DigiRack™ Plug-ins

Version 8.0
Legal Notices

This guide is copyrighted ©2008 by Digidesign, a division of Avid Technology, Inc. (hereafter “Digidesign”), with all rights reserved. Under copyright laws, this guide may not be duplicated in whole or in part without the written consent of Digidesign.

Guide Part Number 9329-59273-00 REV A 11/08

Documentation Feedback

At Digidesign, we’re always looking for ways to improve our documentation. If you have comments, corrections, or suggestions regarding our documentation, email us at techpubs@digidesign.com.
Chapter 1. Introduction ................................................................. 1
    Plug-in Formats ................................................................. 2
    System Requirements and Compatibility .................................. 3
    Plug-ins for Pro Tools .......................................................... 3
    Plug-ins for VENUE ............................................................. 3
    Conventions Used in This Guide ............................................. 4
    About www.digidesign.com .................................................. 4

Chapter 2. Click ................................................................. 5
    Click Controls ................................................................. 5
    Creating a Click Track ....................................................... 6

Chapter 3. DigiRack D-Fx Plug-ins .......................................... 7
    Chorus ................................................................. 7
    Flanger ................................................................. 8
    Multi-Tap Delay .......................................................... 9
    Ping-Pong Delay ........................................................ 10
    Selecting Audio for AudioSuite Delay Processing .................... 11

Chapter 4. Dither ................................................................. 13
    Dither Controls ............................................................ 14

Chapter 5. D-Verb ................................................................. 15
    D-Verb Controls ............................................................ 15
Chapter 6. Dynamics III .......................................................... 19
    Shared Compressor/Limiter and Expander/Gate Features .................. 19
    Compressor/Limiter III ...................................................... 22
    Expander/Gate III .......................................................... 26
    De-Esser III ................................................................. 28
    Using the Side-Chain Input in Dynamics III ................................ 31

Chapter 7. EQ III ................................................................. 35
    EQ III Controls .............................................................. 36
    7 Band EQ ................................................................. 41
    2–4 Band EQ ............................................................... 46
    1 Band EQ ................................................................. 47

Chapter 8. Mod Delay II ........................................................ 51
    Mod Delay II Controls ...................................................... 51
    Multichannel Mod Delay II ................................................ 53
    Selections for ModDelay II AudioSuite Processing ....................... 53

Chapter 9. Pitch ................................................................. 55
    Pitch Controls .............................................................. 55

Chapter 10. Pitch Shift .......................................................... 59

Chapter 11. POW-r Dither ....................................................... 61
    POW-r Dither Controls .................................................... 61

Chapter 12. ReWire .............................................................. 63
    ReWire Requirements ........................................................ 65
    Using ReWire ............................................................... 66
    Quitting ReWire Client Applications ..................................... 68
    Tempo and Meter Changes ................................................ 69
    Looping Playback .......................................................... 69
    Automating ReWire Input Switching ..................................... 70
Chapter 13. Signal Generator ................................................................. 71
  Signal Generator Controls ............................................................. 71
  AudioSuite Processing with Signal Generator ................................. 72

Chapter 14. SignalTools ................................................................. 73
  SurroundScope ........................................................................... 73
  PhaseScope .............................................................................. 74
  SignalTools Display Options ......................................................... 75
  SignalTools Level Meters ............................................................ 77

Chapter 15. TimeAdjuster ................................................................. 79
  TimeAdjuster Controls .................................................................. 79
  Using TimeAdjuster for Manual Delay Compensation ..................... 80
  When to Compensate for Delays ..................................................... 81

Chapter 16. Time Compression/Expansion ........................................ 83

Chapter 17. Time Shift ...................................................................... 85
  Time Shift Displays and Controls .................................................. 85
  Post Production Pull Up and Pull Down Tasks ................................. 90
  AudioSuite Input Modes .............................................................. 91
  AudioSuite Preview .................................................................... 91
  AudioSuite TCE Plug-in Preference ............................................... 91
  Processing Audio .................................................................... 92

Chapter 18. Trim ............................................................................ 93
  Trim Controls ........................................................................... 93

Chapter 19. Other AudioSuite Plug-ins ........................................... 95
  DC Offset Removal ...................................................................... 95
  Duplicate .................................................................................. 95
  Gain .......................................................................................... 96
  Invert ...................................................................................... 96
  Normalize ................................................................................. 97
  Reverse .................................................................................... 98
Appendix A. DSP Requirements for TDM Plug-ins ................................................. 99
   DSP Requirements ......................................................................................... 100

Appendix B. DSP Delays Incurred by TDM Plug-ins ................................. 103

Index .................................................................................................................. 105
chapter 1

Introduction

Plug-ins are special-purpose software components that provide additional signal processing and other functionality to Pro Tools®. The DigiRack™ plug-ins included with Pro Tools provide a comprehensive suite of digital signal processing effects that include EQ, dynamics, delay, and other essential functions.

⚠ References to Pro Tools LE® in this guide are usually interchangeable with Pro Tools M-Powered™, except as noted in the Pro Tools M-Powered Setup Guide.

The DigiRack plug-ins installed with Pro Tools include:
- DigiRack Click
- DigiRack D-Fx plug-ins
  - Chorus
  - Flanger
  - Multi-Tap Delay
  - Ping-Pong Delay
- DigiRack Dither
- DigiRack D-Verb
- DigiRack Dynamics III
  - Compressor/Limiter
  - Expander/Gate
  - De-Esser
- DigiRack EQ III
  - 7 Band
  - 2–4 Band
  - 1 Band
- DigiRack ModDelay II
- DigiRack Pitch
- DigiRack Pitch Shift
- DigiRack POW-r Dither
- DigiRack ReWire
- DigiRack SignalGenerator
- DigiRack SignalTools
  - SurroundScope
  - PhaseScope
- DigiRack TimeAdjuster
- DigiRack Time Compression/Expansion
- DigiRack Time Shift
- DigiRack Trim
• Other DigiRack AudioSuite Plug-ins
  • DC Offset Removal
  • Duplicate
  • Gain
  • Invert
  • Normalize
  • Reverse

Plug-in Formats

There are three plug-in formats used in Pro Tools:
  • TDM plug-ins (real-time, DSP-based)
  • RTAS® plug-ins (real-time, host-based)
  • AudioSuite™ plug-ins (non-real-time, file-based processing)

TDM Plug-ins
(Pro Tools HD and VENUE Only)

TDM (Time Division Multiplexing) plug-ins function as track inserts, are applied to audio during playback, and process audio non-destructively in real time. TDM plug-ins are designed for use with Pro Tools HD software on Pro Tools|HD® systems, and rely on the processing power of Digidesign DSP cards.

The number and variety of TDM plug-ins that you can use simultaneously in a session are limited only by the amount of DSP available. You can increase available DSP by installing additional DSP cards (such as HD Core™, HD Accel, or HD Process™ cards) in your computer. This power-on-demand aspect is a significant advantage of Pro Tools|HD systems.

RTAS Plug-ins

RTAS (Real-Time AudioSuite) plug-ins provide features and functionality similar to their TDM counterparts, but unlike TDM plug-ins, they rely on and are limited by the processing power of your computer. The more powerful your computer, the greater the number and variety of RTAS plug-ins that you can use simultaneously.

Because of this dependence on the CPU or host processing, the more RTAS plug-ins you use concurrently in a session, the greater the impact it will have on other aspects of your system’s performance, such as maximum track count, number of available voices, the density of edits possible, and latency in automation and recording.

RTAS plug-ins can be used with Pro Tools HD, Pro Tools LE.

AudioSuite Plug-ins

AudioSuite plug-ins are used to process and modify audio files on disk, rather than non-destructively in real time. Depending on how you configure a non-real-time AudioSuite plug-in, it either creates an entirely new audio file, or alters the original source audio file. Audio-Suite plug-ins can be used on all Pro Tools systems and Avid software.
System Requirements and Compatibility

To use DigiRack plug-ins you need any the following:

- A Digidesign-qualified Pro Tools system running Pro Tools
- A Digidesign-qualified Pro Tools system and a third-party software application that supports the Digidesign TDM, RTAS, or AudioSuite plug-in standards
- A qualified Avid® Xpress®, Avid Xpress DV, or Avid DNA™ system (AudioSuite only)
- A qualified Digidesign VENUE system (TDM only)

Digidesign can only assure compatibility and provide support for hardware and software it has tested and approved.

For complete system requirements and a list of Digidesign-qualified computers, operating systems, hard drives, and third-party devices, refer to the latest information on the Digidesign website:

www.digidesign.com/compatibility

Plug-ins for Pro Tools

Installing

The Digidesign DigiRack plug-ins are installed when you install Pro Tools. For more information about installing Pro Tools, see the Setup Guide that came with your system.

If installing multiple packages of plug-ins, do so in the following order:

2. Packs and other bundles included with your Digidesign system.
3. Any additional plug-ins. Check with the manufacturer of your plug-ins for compatibility information and support.

Using Plug-ins in Pro Tools

Refer to the Pro Tools Reference Guide for information on working with plug-ins, including:

- Inserting plug-ins on tracks
- Plug-in Window controls
- Adjusting plug-in controls
- Automating plug-ins
- Using side-chain inputs
- Using plug-in presets
- Clip indicators

Plug-ins for VENUE

Installing

VENUE-compatible Digidesign DigiRack plug-ins are pre-installed on your VENUE system and are updated when you update VENUE software. For more information about installing VENUE software, see the documentation that came with your VENUE system.

Using Plug-ins with VENUE

Refer to the documentation that came with your VENUE system for information on working with plug-ins.
Conventions Used in This Guide

All Digidesign guides use the following conventions to indicate menu choices and key commands:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Save</td>
<td>Choose Save from the File menu</td>
</tr>
<tr>
<td>Control+N</td>
<td>Hold down the Control key and press the N key</td>
</tr>
<tr>
<td>Control-click</td>
<td>Hold down the Control key and click the mouse button</td>
</tr>
<tr>
<td>Right-click</td>
<td>Click with the right mouse button</td>
</tr>
</tbody>
</table>

The names of Commands, Options, and Settings that appear on-screen are in a different font.

The following symbols are used to highlight important information:

💡 **User Tips** are helpful hints for getting the most from your Pro Tools system.

⚠️ **Important Notices** include information that could affect your Pro Tools session data or the performance of your Pro Tools system.

🔍 **Shortcuts** show you useful keyboard or mouse shortcuts.

🔍 **Cross References** point to related sections in this guide and other Digidesign guides.

About www.digidesign.com

The Digidesign website (www.digidesign.com) is your best online source for information to help you get the most out of your Pro Tools system. The following are just a few of the services and features available.

**Product Registration** Register your purchase online.

**Support and Downloads** Contact Digidesign Technical Support or Customer Service; download software updates and the latest online manuals; browse the Compatibility documents for system requirements; search the online Answerbase; or join the worldwide Pro Tools community on the Digidesign User Conference.

**Training and Education** Study on your own using courses available online or find out how you can learn in a classroom setting at a certified Pro Tools training center.

**Products and Developers** Learn about Digidesign products; download demo software or learn about our Development Partners and their plug-ins, applications, and hardware.

**News and Events** Get the latest news from Digidesign or sign up for a Pro Tools demo.

**Pro Tools Accelerated Videos** Watch the series of free tutorial videos. Accelerated Videos are designed to help you get up and running with Pro Tools and its plug-ins quickly.
Chapter 2

Click

(TDM and RTAS)

The Click plug-in creates an audio click during session playback that you can use as a tempo reference when performing and recording. The Click plug-in receives its tempo and meter data from the Pro Tools application, enabling it to follow any changes in tempo and meter in a session. The Click plug-in is a mono-only plug-in. Several click sound presets are included.

Click Controls

**MIDI In LED** Illuminates each time the Click plug-in receives a click message from the Pro Tools application, indicating the click tempo.

**Accented** Controls the output level of the accent beat (beat 1 of each bar) of the audio click.

**Unaccented** Controls the output level of the unaccented beats of the audio click.
Creating a Click Track

To create a click track with the Click plug-in:

1. Ensure that the Options > Click is enabled.
2. Choose Track > Create Click Track.

Pro Tools creates a new Auxiliary Input track named “Click” with the Click plug-in already inserted. In the Edit window, the track’s Track Height is set to Mini.

To manually create a click track with the Click plug-in:

1. Select Options > Click to enable the Click option (or enable the Metronome button in the Transport).
2. Create a new mono Auxiliary Input track and insert the Click plug-in.
3. Select a click sound preset.
4. Choose Setup > Click/Countoff and set the Click and Countoff options as desired.

⚠️ The Note, Velocity, Duration, and Output options in this dialog are for use with MIDI instrument-based clicks and do not affect the Click plug-in.

5. Begin playback. A click is generated according to the tempo and meter of the current session and the settings in the Click/Countoff Options dialog.

Refer to the Pro Tools Reference Guide for more information on configuring Click options.
DigiRack D-Fx Plug-ins

(AudioSuite Only)

D-Fx provides four modules:
- Chorus
- Flanger
- Multi-Tap Delay
- Pin-Pong Delay

Chorus

(AudioSuite Only)

Chorus adds a shimmering quality to audio material by combining a time-delayed, pitch-shifted copy of an audio signal with itself.

- Gain Adjusts the input volume of the chorus to prevent clipping or increase the level of the processed signal. This slider is set to a default of +3 dB. If your source audio has been recorded very close to peak level, this +3 dB default setting could cause clipping. Use this control to reduce the input level.

- Selecting the Sum Inputs button sums the dry input signals (mono or stereo) before processing them. The dry signal then appears in the center of the stereo field and the wet, effected signal will be output in stereo.

- When the Sum Inputs button is selected, the LFO waveform on the right channel is automatically phase inverted to enhance the mono-stereo effect.

- Mix Adjusts the balance between the effected signal and the original signal and controls the depth of the effect. Mix is adjustable from 0% to 100%.

- Low-Pass Filter Controls the cutoff frequency of the Low-Pass Filter. Use this to attenuate the high frequency content of the feedback signal. The lower the setting, the more high frequencies are removed from the feedback signal.

The Chorus plug-in was formerly called D-fx Chorus. It is fully compatible with all settings and presets created for D-fx Chorus.
The range of the Low-Pass Filter is 20 Hz to 19.86 kHz, with a maximum value of Off (which effectively means bypass).

**Delay** Sets the delay time between the original signal and the chorused signal. The higher the setting, the longer the delay and the wider the chorusing effect. Delay is adjustable from 0–20 milliseconds.

**LFO Rate** Adjusts the rate of the LFO (low frequency oscillator) applied to the delayed signal as modulation. The higher the setting, the more rapid the modulation. You can select either a sine wave or a triangle wave as a modulation source, using the LFO Waveform selector.

**LFO Width** Adjusts the intensity of the LFO applied to the delayed signal as modulation. The higher the setting, the more intense the modulation. Use the LFO Waveform selector to select a sine or a triangle wave as a modulation source.

**Feedback** Controls the amount of feedback applied from the output of the delayed signal back into its input. Negative settings provide a more intense effect.

**LFO Waveform** Selects a sine wave or triangle wave for the LFO. This affects the character of the modulation. The sine wave has a gentler ramp and peak than the triangle wave.

---

**Flanger**

*(AudioSuite Only)*

The Flanger animates and adds a swirling, moving quality to audio material by combing a time-delayed copy of an audio signal with itself.

The Flanger uses a *through-zero* flanging algorithm that results in a tape-like flanging effect. This technique delays the original dry signal by 256 samples, then modulates the delayed signal back and forth in time in relation to the dry signal, passing through its zero point on the way.

**Flanger plug-in**

- The Flanger plug-in was formerly called D-fx Flanger. It is fully compatible with all settings and presets created for D-fx Flanger.

**Gain** Adjusts the input volume of the flanger to prevent clipping or increase the level of the processed signal. This slider is set to a default of +3 dB. If your source audio has been recorded very close to peak level, this +3 dB default setting could cause clipping. Use this control to reduce the input level.

Selecting the Sum Inputs button sums the dry input signals (mono and stereo) before processing them. The dry signal then appears in the center of the stereo field and the wet, effected signal will be output in stereo.
When the Sum Inputs button is selected, the LFO waveform on the right channel is phase inverted to enhance the mono-stereo effect.

**Mix** Adjusts the balance between the effected signal and the original signal and controls the depth of the effect. Mix is adjustable from 0% to 100%.

**High-Pass Filter** Controls the cutoff frequency of the high-pass filter. Use this to attenuate the frequency content of the feedback signal and the frequency response of the flanging. The higher the setting, the more low frequencies are removed from the feedback signal.

**LFO Rate** Adjusts the rate of the LFO (low frequency oscillator) applied to the delayed signal as modulation. The higher the setting, the more rapid the modulation. You can select either a sine wave or a triangle wave as a modulation source, using the LFO Waveform selector.

**LFO Width** Adjusts the intensity of the LFO applied to the delayed signal as modulation. The higher the setting, the more intense the modulation.

**Feedback** Controls the amount of feedback applied from the output of the delayed signal back into its input. Negative settings provide a more intense effect.

**LFO Waveform** Selects a sine wave or triangle wave for the LFO. This affects the character of the modulation. The sine wave has a gentler ramp and peak than the triangle wave.

---

**Multi-Tap Delay**

(*AudioSuite Only*)

The Multi-Tap Delay adds up to four independently-controllable delays or taps to the original audio signal. Use the Multi-tap delay to add spatialization or complex rhythmic echo effects to audio material. You can individually control the delay time and number of repetitions of each of the four taps.

**Multi-Tap Delay plug-in**

The Multi-Tap Delay plug-in was formerly called D-fx Multi-Tap Delay. It is fully compatible with all settings and presets created for D-fx Multi-Tap Delay.
**Gain** Provides individual control of the input level for each of the four delay lines (or “taps”). Individually adjust the Gain for each of the four taps, either to prevent clipping or to increase the level of the processed signal.

Selecting the Sum Inputs button sums the dry input signals (mono or stereo) before processing them. The dry signal then appears in the center of the stereo field and the wet, effected signal will be output in stereo.

**Feedback** Provides individual control over the amount of feedback applied from the output of the delay into its input for each tap. It also controls the number of repetitions of the delayed signal. For the feedback feature to function, the Gain slider for that tap must be raised above its lowest setting.

**Pan** Provides individual control over the apparent location of each of the four taps in the stereo field.

**Delay** Sets the delay time between the original signal and the delayed signal. The higher the setting, the longer the delay. This control is adjustable from 0–1500 milliseconds (1.5 seconds).

**Mix** Adjusts the balance between the effected signal and the original signal and controls the depth of the effect. Mix is adjustable from 0% to 100%.

---

**Ping-Pong Delay**

**(AudioSuite Only)**

The Ping-Pong Delay plug-in adds a controllable delay to the original audio signal. Use the Ping-Pong delay to add spatialization, and panned echo to audio material. This plug-in feeds back delayed signals to their opposite channels, creating a characteristic ping-pong echo effect.

---

**Ping-Pong Delay plug-in**

💡 The Ping-Pong Delay plug-in was formerly called D-fx Ping-Pong Delay. It is fully compatible with all settings and presets created for D-fx Ping-Pong Delay.

**Gain** Adjusts the input volume of the Ping-Pong Delay to prevent clipping or to increase the level of the processed signal.

**Mix** Adjusts the balance between the effected signal and the original signal and controls the depth of the effect. Mix is adjustable from 0% to 100%.

**Delay** Sets the delay time between the original signal and the delayed signal. The higher the setting, the longer the delay. This control is adjustable from 0–1500 milliseconds (1.5 seconds).

**Low-Pass Filter** Controls the cutoff frequency of the low-pass filter. Use this to attenuate the high frequency content of the feedback signal. The lower the setting, the more high frequencies are removed from the feedback signal.
The range of the Low-Pass Filter is 20 Hz to 19.86 kHz, with a maximum value of Off (which effectively means bypass).

**Feedback** Controls the amount of feedback applied from the output of the delay into its input. It also controls the number of repetitions of the delayed signal.

**Cross-Feedback** Cross-Feedback feeds the delayed signals to their opposite channel: The left channel delay is fed to the right channel input and vice-versa. The result is a stereo echo that ping-pongs back and forth between the right and left channels.

---

**Selecting Audio for AudioSuite Delay Processing**

Because delays add additional material to the end of selected audio (a delay tap), make a selection that is longer than the original source material so AudioSuite can write the additional delayed audio to the audio file.

Selecting only the original material, without leaving additional space at the end results in the delayed audio being cutoff at the end of the selection. To accommodate delayed audio that comes after the source audio, place the region in a track, and select the desired audio plus an amount of blank space at the end of the region equal to the amount of delay that you have added in the plug-in. The plug-in will then have space at the end of the region in which to write the final delay.
The Dither plug-in minimizes quantization artifacts when reducing the bit depth of an audio signal to 16-, 18-, or 20-bit resolution.

For more advanced dithering, use the Digi-Rack POW-r Dither plug-in. See Chapter 11, “POW-r Dither.”

The Dither plug-in has user-selectable bit resolution and a noise shaping on/off option.

If you are mixing down to an analog destination with any 24-bit capable interface, you do not need to use Dither. This allows maximum output fidelity from the 24-bit digital-to-analog convertors of the interface.
Dither Controls

Bit Resolution

Use this pop-up menu to choose one of three possible resolutions for the Dither processing. Set this control to the maximum bit resolution of your destination.

16-bit Recommended for output to digital devices with a maximum resolution of 16 bits, such as DAT and CD recorders.

18-bit Recommended for output to digital devices with a maximum resolution of 18 bits.

20-bit Recommended for output to digital devices that support a full 20-bit recording data path, such as the Sony PCM-9000 optical mastering recorder, or the Alesis ADAT XT 20. Use this setting for output to analog devices if you are using a 20-bit audio interface, such as the 882|20 I/O audio interface. The 20-bit setting can also be used for output to digital effects devices that support 20-bit input and output, since it provides for a lower noise floor and greater dynamic range when mixing 20-bit signals directly into Pro Tools.

⚠️ The DigiRack Dither plug-in only provides eight channels of uncorrelated dithering noise. If DigiRack Dither is used on more than eight tracks, the dithering noise begins to repeat and dither performance is impaired. For example, if two Quad DigiRack Dithers are used, both Quad instances of Dither will have all of their dither noise uncorrelated. However, any additional instances of the Dither plug-in will begin to repeat the dithering noise.

Noise Shaping

Noise shaping can further improve audio performance and reduce perceived noise inherent in dithered audio. Noise shaping uses filtering to shift noise away from frequencies in the middle of the audio spectrum (around 4 kHz), where the human ear is most sensitive.

The Noise Shaping button engages or disengages Noise shaping. Noise shaping is on when the button is highlighted in blue.
D-Verb is a studio-quality reverb provided in TDM, RTAS, and AudioSuite formats.

⚠️ The TDM version of the D-Verb plug-in is not supported at 192 kHz; use the RTAS version instead.

### D-Verb Controls

**Output Meter**

The Output meter indicates the output level of the processed signal. With the stereo version of D-verb, it represents the summed stereo output. It is important to note that this meter indicates the output level of the signal—not the input level. If this meter clips, it is possible that the signal clipped on input before it reached D-Verb. Monitor your send or insert signal levels closely to help prevent this from happening.

**Clip Indicator**

The Clip indicator shows if clipping has occurred. It is a clip-hold indicator. If clipping occurs at any time during audio playback, the clip lights remain on. To clear the clip indicator, click it. With longer reverb times there is a greater likelihood of clipping occurring as the feedback element of the reverb builds up and approaches a high output level. See also “Clip Indicators” on page 22.

**Input Level**

The Input Level slider adjusts the input volume of the reverb to prevent the possibility of clipping and/or increase the level of the processed signal.

**Mix**

The Mix slider adjusts the balance between the dry signal and the effected signal, giving you control over the depth of the effect. This control is adjustable from 100% to 0%.
Algorithm

This control selects one of seven reverb algorithms: Hall, Church, Plate, Room 1, Room 2, Ambience, or Nonlinear. Selecting an algorithm changes the preset provided for it. Switching the Size setting changes characteristics of the algorithm that are not altered by adjusting the decay time and other user-adjustable controls. Each of the seven algorithms has a distinctly different character:

**Hall** A good general purpose concert hall with a natural character. It is useful over a large range of size and decay times and with a wide range of program material. Setting Decay to its maximum value will produce infinite reverberation.

**Church** A dense, diffuse space simulating a church or cathedral with a long decay time, high diffusion, and some pre-delay.

**Plate** Simulates the acoustic character of a metal plate-based reverb. This type of reverb typically has high initial diffusion and a relatively bright sound, making it particularly good for certain percussive signals and vocal processing. Plate reverb has the general effect of thickening the initial sound itself.

**Room 1** A medium-sized, natural, rich-sounding room that can be effectively varied in size between very small and large, with good results.

**Room 2** A smaller, brighter reverberant characteristic than Room 1, with a useful adjustment range that extends to “very small.”

**Ambient** A transparent response that is useful for adding a sense of space without adding a lot of depth or density. Extreme settings can create interesting results.

**Nonlinear** Produces a reverberation with a natural buildup and an abrupt cutoff similar to a gate. This unnatural decay characteristic is particularly useful on percussion, since it can add an aggressive characteristic to sounds with strong attacks.

Size

The Size control, in conjunction with the Algorithm control, adjusts the overall size of the reverberant space. There are three sizes: Small, Medium, and Large. The character of the reverberation changes with each of these settings (as does the relative value of the Decay setting). The Size buttons can be used to vary the range of a reverb from large to small. Generally, you should select an algorithm first, and then choose the size that approximates the size of the acoustic space that you are trying to create.

Diffusion

Diffusion sets the degree to which initial echo density increases over time. High settings result in high initial build-up of echo density. Low settings cause low initial buildup. This control interacts with the Size and Decay controls to affect the overall reverb density. High settings of diffusion can be used to enhance percussion. Use low or moderate settings for clearer and more natural-sounding vocals and mixes.

Decay

Decay controls the rate at which the reverb decays after the original direct signal stops. The value of the Decay setting is affected by the Size and Algorithm controls. This control can be set to infinity on most algorithms for infinite reverb times.
**Pre-Delay**

Pre-Delay determines the amount of time that elapses between the original audio event and the onset of reverberation. Under natural conditions, the amount of pre-delay depends on the size and construction of the acoustic space, and the relative position of the sound source and the listener. Pre-Delay attempts to duplicate this phenomenon and is used to create a sense of distance and volume within an acoustic space. Long Pre-Delay settings place the reverberant field behind rather than on top of the original audio signal.

**Hi Frequency Cut**

Hi Frequency Cut controls the decay characteristic of the high frequency components of the reverb. It acts in conjunction with the Low-Pass Filter control to create the overall high frequency contour of the reverb. When set relatively low, high frequencies decay more quickly than low frequencies, simulating the effect of air absorption in a hall. The maximum value of this control is Off (which effectively means bypass).

**Low-Pass Filter**

Low-Pass Filter controls the overall high frequency content of the reverb by setting the frequency above which a 6 dB per octave filter attenuates the processed signal. The maximum value of this control is Off (which effectively means bypass).
Dynamics III provides three modules:
- Compressor/Limiter
- Expander/Gate
- De-Esser

All Dynamics III modules are available in TDM, RTAS, and AudioSuite formats.

Dynamics III supports 44.1 kHz, 48 kHz, 88.2 kHz, 96 kHz, 176.4 kHz and 192 kHz sample rates. Compressor/Limiter and Expander/Gate modules work with mono, stereo, and greater-than-stereo multichannel formats up to 7.1. The De-Esser module works with mono and stereo formats only.

In addition to standard controls in each module, Dynamics III also provides a graph to track the gain transfer curve in the Compressor/Limiter and Expander/Gate plug-ins, and a frequency graph to display which frequencies trigger the De-Esser and which frequencies will be gain reduced.

---

Shared Compressor/Limiter and Expander/Gate Features

The following parts of the user interface are shared between the Compressor/Limiter and Expander/Gate Dynamics III plug-ins.

Levels Section

The indicators and controls in the Levels section let you track input, output, and gain reduction levels, as well as work with phase invert and the threshold setting.

See “De-Esser Levels Section” on page 29 for more information on De-Esser III Input/Output Level controls.
**Input and Output Meters**

The Input (In) and Output (Out) meters show peak signal levels before and after dynamics processing:

- **Green** Indicates nominal levels.
- **Yellow** Indicates pre-clipping levels, starting at −6 dB below full scale.
- **Red** Indicates full scale levels (clipping).

The clip indicators at the top of the Output meters indicate clipping at the input or output stage of the plug-in. Clip indicators can be cleared by clicking the indicator.

💡 The Input and Output meters display differently depending on the type of track (mono, stereo, or multichannel) on which the plug-in has been inserted.

💡 When Side-Chain Listen is enabled, the Output meter only displays the levels of the side-chain signal. See “Side-Chain Listen” on page 31.

**Toggling Multichannel Input and Output Meters**

With multichannel track types LCRS and higher, both Input and Output meters cannot be shown at the same time. Click either the Input or Output button to display the appropriate level meter. The Input/Output meters display is toggled to Output by default.

**Gain Reduction Meter**

The Gain Reduction (GR) meter indicates the amount the input signal is attenuated (in dB) and shows different colors during dynamics processing:

- **Light Orange** Indicates that gain reduction is within the “knee” and has not reached the full ratio of compression.
- **Dark Orange** Indicates that gain reduction is being applied at the full ratio (for example, 2:1).

**Threshold Arrow**

The orange Threshold arrow next to the Input meter indicates the current threshold, and can be dragged up or down to adjust the threshold. When a multichannel instance of the plug-in has been configured to show only the Output meter, the Threshold arrow is not displayed.

**Phase Invert**

The Phase Invert button inverts the phase (polarity) of the input signal, to help compensate for phase anomalies that can occur either in multi-microphone environments or because of mis-wired balanced connections.
**LFE Enable**

*(Pro Tools HD and Pro Tools LE with Complete Production Toolkit Only)*

The LFE Enable button (located in the Options section) is on by default, and enables plug-in processing of the LFE (low frequency effects) channel on a multichannel track formatted for 5.1, 6.1, or 7.1 surround formats. To disable LFE processing, deselect this button.

---

The LFE Enable button is not available if the plug-in is not inserted on an applicable track.

---

**Dynamics Graph Display**

The Dynamics Graph display—used with the Compressor/Limiter and Expander/Gate plug-ins—shows a curve that represents the level of the input signal (on the x–axis) and the level of the output signal (on the y–axis). The orange vertical line represents the threshold.

---

Use this graph as a visual guideline to see how much dynamics processing you are applying.

---

The Compressor/Limiter and Expander/Gate plug-ins also feature an animated, multi-color cursor in their gain transfer curve displays.

The gain transfer curve of the Compressor/Limiter and Expander/Gate plug-ins shows a moving ball cursor that shows the amount of input gain (x-axis) and gain reduction (y-axis) being applied to the incoming signal.

---

Gain transfer curve and cursor showing amount of compression
To indicate overshoots (when an incoming signal peak is too fast for the current compression setting) the cursor temporarily leaves the gain transfer curve.

The cursor changes color to indicate the amount of compression applied, as follows:

### Dynamics III Plug-in Compression Amount

<table>
<thead>
<tr>
<th>Cursor Color</th>
<th>Compression Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>white</td>
<td>no compression</td>
</tr>
<tr>
<td>light orange</td>
<td>below full ratio</td>
</tr>
<tr>
<td>dark orange</td>
<td>full ratio amount</td>
</tr>
</tbody>
</table>

See “De-Esser Frequency Graph Display” on page 30 for information on using the De-Esser’s graph display.

### Side-Chain Section

For information on using the Side-Chain section of the Compressor/Limiter or Expander/Gate, see “Using the Side-Chain Input in Dynamics III” on page 31.

## Compressor/Limiter III

The Compressor/Limiter plug-in applies either compression or limiting to audio material, depending on the ratio of compression used.

### About Compression

Compression reduces the dynamic range of signals that exceed a chosen threshold by a specific amount. The Threshold control sets the level that the signal must exceed to trigger compression. The Attack control sets how quickly the compressor responds to the “front” of an audio signal once it crosses the selected threshold. The Release control sets the amount of time that it takes for the compressor’s gain to return to its original level after the input signal drops below the selected threshold.

To use compression most effectively, the attack time should be set so that signals exceed the threshold level long enough to cause an increase in the average level. This helps ensure that gain reduction does not decrease the overall volume too drastically, or eliminate desired attack transients in the program material.

Of course, compression has many creative uses that break these rules.
**About Limiting**

Limiting prevents signal peaks from ever exceeding a chosen threshold, and is generally used to prevent short-term peaks from reaching their full amplitude. Used judiciously, limiting produces higher average levels, while avoiding overload (clipping or distortion), by limiting only some short-term transients in the source audio. To prevent the ear from hearing the gain changes, extremely short attack and release times are used.

Limiting is used to remove only occasional peaks because gain reduction on successive peaks would be noticeable. If audio material contains many peaks, the threshold should be raised and the gain manually reduced so that only occasional, extreme peaks are limited.

Limiting generally begins with the ratio set at 10:1 and higher. Large ratios effectively limit the dynamic range of the signal to a specific value by setting an absolute ceiling for the dynamic range.

**Compressor/Limiter III Controls**

This section describes controls for the Compressor/Limiter plug-in.

**Input/Output Level Meters**

The Input and Output meters show peak signal levels before and after dynamics processing. See “Levels Section” on page 19 for more information.

Unlike scales on analog compressors, metering scales on a digital device reflect a 0 dB value that indicates full scale (fs)—the full-code signal level. There is no headroom above 0 dB.

**Compressor/Limiter Graph Display**

The Dynamics Graph display lets you visually see how much expansion or gating you are applying to your audio material. See “Dynamics Graph Display” on page 21.

**Threshold**

The Threshold (Thresh) control sets the level that an input signal must exceed to trigger compression or limiting. Signals that exceed this level will be compressed. Signals that are below it will be unaffected.

This control has an approximate range of –60 dB to 0 dB, with a setting of 0 dB equivalent to no compression or limiting. The default value for the Threshold control is –24 dB.
An orange arrow on the Input meter indicates the current threshold, and can also be dragged up or down to adjust the threshold setting.

![Threshold arrow on input meter](image)

The Dynamics Graph display also shows the threshold as an orange vertical line.

![Threshold indicator on Dynamics Graph display](image)

**Threshold arrow on input meter**

The Dynamics Graph display also shows the threshold as an orange vertical line.

**Threshold indicator on Dynamics Graph display**

This control ranges from –60 dB (lowest gain) to 0 dB (highest gain).

**Ratio**

The Ratio control sets the compression ratio, or the amount of compression applied as the input signal exceeds the threshold. For example, a 2:1 compression ratio means that a 2 dB increase of level above the threshold produces a 1 db increase in output.

This control ranges from 1:1 (no compression) to 100:1 (hard limiting).

**Attack**

The Attack control sets the attack time, or the rate at which gain is reduced after the input signal crosses the threshold.

The smaller the value, the faster the attack. The faster the attack, the more rapidly the Compressor/Limiter applies attenuation to the signal. If you use fast attack times, you should generally use a proportionally longer release time, particularly with material that contains many peaks in close proximity.

This control ranges from 10 μs (fastest attack time) to 300 ms (slowest attack time).

**Release**

The Release control sets the length of time it takes for the Compressor/Limiter to be fully deactivated after the input signal drops below the threshold.

Release times should be set long enough that if signal levels repeatedly rise above the threshold, the gain reduction “recovers” smoothly. If the release time is too short, the gain can rapidly fluctuate as the compressor repeatedly tries to recover from the gain reduction. If the release time is too long, a loud section of the audio material could cause gain reduction that continues through soft sections of program material without recovering.

This control ranges from 5 ms (fastest release time) to 4 seconds (slowest release time).
**Knee**

The Knee control sets the rate at which the compressor reaches full compression once the threshold has been exceeded.

As you increase this control, it goes from applying “hard-knee” compression to “soft-knee” compression:

- With hard-knee compression, compression begins when the input signal exceeds the threshold. This can sound abrupt and is ideal for limiting.
- With soft-knee compression, gentle compression begins and increases gradually as the input signal approaches the threshold, and reaches full compression after exceeding the threshold. This creates smoother compression.

For example, a Knee setting of 10 dB would be the gain range over which the ratio gradually increased to the set ratio amount.

The Gain Reduction meter displays light orange while gain reduction has not exceeded the knee setting, and switches to dark orange when gain reduction reaches the full ratio.

This control ranges from 0 dB (hardest response) to 30 dB (softest response).

**Gain**

The Gain control lets you boost overall output gain to compensate for heavily compressed or limited signals.

This control ranges from 0 dB (no gain boost) to +40 dB (loudest gain boost), with the default value at 0 dB.

> For more information on the LFE channel, refer to the Pro Tools Reference Guide.

**Side-Chain Section**

The side-chain is the split-off signal used by the plug-in’s detector to trigger dynamics processing. The Side-Chain section lets you toggle the side-chain between the internal input signal or an external key input, and tailor the equalization of the side-chain signal so that the triggering of dynamics processing becomes frequency-sensitive. See “Using the Side-Chain Input in Dynamics III” on page 31.

*Graph examples of hard and soft knee compression*

For example, a Knee setting of 10 dB would be the gain range over which the ratio gradually increased to the set ratio amount.

The Gain Reduction meter displays light orange while gain reduction has not exceeded the knee setting, and switches to dark orange when gain reduction reaches the full ratio.

This control ranges from 0 dB (hardest response) to 30 dB (softest response).
Expander/Gate III

The Expander/Gate plug-in applies expansion or gating to audio material, depending on the ratio setting.

About Expansion

Expansion decreases the gain of signals that fall below a chosen threshold. They are particularly useful for reducing noise or signal leakage that creeps into recorded material as its level falls, as often occurs in the case of headphone leakage.

About Gating

Gating silences signals that fall below a chosen threshold. To enable gating, simply set the Ratio and Range controls to their maximum values.

Expanders can be thought of as soft noise gates since they provide a gentler way of reducing noisy low-level signals than the typically abrupt cutoff of a gate.

Expander/Gate III Controls

This section describes controls for the Expander/Gate plug-in.

Input/Output Level Meters

The Input and Output meters show peak signal levels before and after dynamics processing. See “Levels Section” on page 19 for more information.

Expander/Gate Dynamics Graph Display

The Dynamics Graph display lets you visually see how much expansion or gating you are applying to your audio material. See “Dynamics Graph Display” on page 21.

Look Ahead Button

Normally, dynamics processing begins when the level of the input signal crosses the threshold. When the Look Ahead button is enabled, dynamics processing begins 2 milliseconds before the level of the input signal crosses the threshold.

The Look Ahead control is useful for avoiding the loss of transients that may have been otherwise cut off or trimmed in a signal.
**Threshold**

The Threshold (Thresh) control sets the level below which an input signal must fall to trigger expansion or gating. Signals that fall below the threshold will be reduced in gain. Signals that are above it will be unaffected.

An orange arrow on the Input meter indicates the current threshold, and can also be dragged up or down to adjust the threshold setting.

![Threshold arrow on Input meter](image1)

This control has an approximate range of –60 dB to 0 dB, with a setting of 0 dB equivalent to no compression or limiting. The default value for the Threshold control is –24 dB.

**Ratio**

The Ratio control sets the amount of expansion. For example, if this is set to 2:1, it will lower signals below the threshold by one half. At higher ratio levels (such as 30:1 or 40:1) the Expander/Gate functions like a gate by cutting off signals that fall below the threshold. As you adjust the ratio control, refer to the built-in graph to see how the shape of the expansion curve changes.

This control ranges from 1:1 (no expansion) to 100:1 (gating).

**Attack**

The Attack control sets the attack time, or the rate at which gain is reduced after the input signal crosses the threshold. Use this along with the Ratio setting to control how soft the Expander’s gain reduction curve is.

This control ranges from 10 μs (fastest attack time) to 300 ms (slowest attack time).

**Hold**

The Hold control specifies the duration (in seconds or milliseconds) during which the Expander/Gate will stay in effect after the initial attack occurs. This can be used as a function to keep the Expander/Gate in effect for longer periods of time with a single crossing of the threshold. It can also be used to prevent gate chatter that may occur if varying input levels near the threshold cause the gate to close and open very rapidly.

This control ranges from 5 ms (shortest hold) to 4 seconds (longest hold).
**Release**

The **Release** control sets how long it takes for the gate to close after the input signal falls below the threshold level and the hold time has passed.

This control ranges from 5 ms (fastest release time) to 4 seconds (slowest release time).

**Range**

The **Range** control sets the depth of the Expander/Gate when closed. Setting the gate to higher range levels allows more and more of the gated audio that falls below the threshold to peek through the gate at all times.

This control ranges from –80 dB (lowest depth) to 0 dB (highest depth).

**Side-Chain Section**

The side-chain is the split-off signal used by the plug-in’s detector to trigger dynamics processing. The Side-Chain section lets you toggle the side-chain between the internal input signal or an external key input, and tailor the equalization of the side-chain signal so that the triggering of dynamics processing becomes frequency-sensitive. See “Using the Side-Chain Input in Dynamics III” on page 31.

**De-Esser III**

The **De-Esser** reduces sibilants and other high frequency noises that can occur in vocals, voice-overs, and wind instruments such as flutes. These sounds can cause peaks in an audio signal and lead to distortion.

The De-Esser reduces these unwanted sounds using fast-acting compression. The Threshold control sets the level above which compression starts, and the Frequency (Freq) control sets the frequency band in which the De-Esser operates.
Using De-Essing Effectively

To use de-essing most effectively, insert the De-Esser after compressor or limiter plug-ins.

The Frequency control should be set to remove sibilants (typically the 4–10 kHz range) and not other parts of the signal. This helps prevent de-essing from changing the original character of the audio material in an undesired manner.

Similarly, the Range control should be set to a level low enough so that de-essing is triggered only by sibilants. If the Range is set too high, a loud, non-sibilant section of audio material could cause unwanted gain reduction or cause sibilants to be over-attenuated.

To improve de-essing of material that has both very loud and very soft passages, automate the Range control so that it is lower on soft sections.

The De-Esser has no control to directly adjust the threshold level (the level that an input signal must exceed to trigger de-essing). The amount of de-essing will vary with the input signal.

De-Esser III Controls

This section describes controls for the De-Esser plug-in.

De-Esser Levels Section

These controls let you track input, output, and gain reduction levels.

De-Esser III I/O Meter display

Input and Output Meters

The Input and Output meters show peak signal levels before and after dynamics processing:

Green Indicates nominal levels.

Yellow Indicates pre-clipping levels, starting at –6 dB below full scale.

Red Indicates full scale levels (clipping).

The Clip indicators at the top of each meter indicate clipping at the input or output stage of the plug-in. Clip indicators can be cleared by clicking the indicator.
**Gain Reduction Meter**

The Gain Reduction meter indicates the amount the input signal is attenuated, in dB. This meter shows different colors during de-essing:

**Light Orange** Indicates that gain reduction is being applied, but has not reached the maximum level set by the Range control.

**Dark Orange** Indicates that gain reduction has reached the maximum level set by the Range control.

**Frequency**

The Frequency (Freq) control sets the frequency band in which the De-Esser operates. When HF Only is disabled, gain is reduced in frequencies within the specified range. When HF Only is enabled, the gain of frequencies above the specified value will be reduced.

This control ranges from 500 Hz (lowest frequency) to 16 kHz (highest frequency).

**Range**

The Range control defines the maximum amount of gain reduction possible when a signal is detected at the frequency set by the Frequency control.

This control ranges from –40 dB (maximum de-essing) to 0 dB (no de-essing).

**HF Only**

When the HF Only button is enabled, gain reduction is applied only to the active frequency band set by the Frequency control. When the HF Only button is disabled, the De-Esser applies gain reduction to the entire signal.

**Listen**

When enabled, the Listen button lets you monitor the sibilant peaks used by the De-Esser as a side-chain to trigger compression. This is useful for listening only to the sibilance for fine-tuning De-Esser controls. To monitor the whole output signal without this filtering, deselect the Listen button.

**De-Esser Frequency Graph Display**

The De-Esser Frequency Graph display shows a curve that represents the level of gain reduction (on the y-axis) for the range of the output signal’s frequency (on the x-axis). The white line represents the current Frequency setting, and the animated orange line represents the level of gain reduction being applied to the signal.

Use this graph as a visual guideline to see how much dynamics processing you are applying at different points in the frequency spectrum.
Using the Side-Chain Input in Dynamics III

(Compressor/Limiter and Expander/Gate Only)

Dynamics processors typically use the detected amplitude of their input signal to trigger gain reduction. This split-off signal is known as the side-chain. The Compressor/Limiter and Expander/Gate plug-ins feature external key capabilities and filters for the side-chain.

With external key side-chain processing, you trigger dynamics processing using an external signal (such as a separate reference track or audio source) instead of the input signal. This external source is known as the key input.

With side-chain filters, you can make dynamics processing more or less sensitive to certain frequencies. For example, you might configure the side-chain so that certain lower frequencies on a drum track trigger dynamics processing.

Side-Chain Section

The Side-Chain section lets you toggle the side-chain between the internal input signal or an external key input, listen to the side-chain, and tailor the equalization of the side-chain signal so that the triggering of dynamics processing becomes frequency-sensitive.

External Key

The External Key toggles external side-chain processing on or off. When this button is highlighted, the plug-in uses the amplitude of a separate reference track or external audio source to trigger dynamics processing. When this button is dark gray, the External Key is disabled and the plug-in uses the amplitude of the input signal to trigger dynamics processing.

Side-Chain Listen

When enabled, this control lets you listen to the internal or external side-chain input by itself, as well as monitor its levels with the Output meter. This is especially useful for fine-tuning the plug-in’s filter settings or external key input.

⚠️ Side-Chain Listen is not saved with other plug-in presets.
**HF and LF Filter Enable Buttons**

The HF Filter Enable and LF Filter Enable buttons toggle the corresponding filter in or out of the side-chain. When this button is highlighted, the filter is applied to the side-chain signal. When this button is dark gray, the filter is bypassed and available for activation.

**HF Frequency Control**

The Frequency control sets the frequency position for the Band-Pass or Low-Pass filter, and ranges from 80 Hz to 20 kHz.

**Low-Frequency (LF) Filter Type**

The LF filter section lets you filter lower frequencies out of the side-chain signal so that only certain bands of low frequencies or higher frequencies are allowed to pass through to trigger dynamics processing. The LF side-chain is switchable between Band-Pass and High-Pass filters.

**Band-Pass Filter** Makes triggering of dynamics processing more sensitive to frequencies within the narrow band centered around the Frequency setting, and rolling off at a slope of 12 dB per octave.

**High-Pass Filter** Makes triggering of dynamics processing more sensitive to frequencies above the Frequency setting rolling off at a slope of 12 dB per octave.

**LF Frequency Control**

The Frequency control sets the frequency position for the Band-Pass or High-Pass filter, and ranges from 25 Hz to 4 kHz.

**High-Frequency (HF) Filter Type**

The HF filter section lets you filter higher frequencies out of the side-chain signal so that only certain bands of high frequencies or lower frequencies pass through to trigger dynamics processing. The HF side-chain filter is switchable between Band-Pass and Low-Pass filters.

**Band-Pass Filter** Makes triggering of dynamics processing more sensitive to frequencies within the narrow band centered around the Frequency setting, and rolling off at a slope of 12 dB per octave.

**Low-Pass Filter** Makes triggering of dynamics processing more sensitive to frequencies below the Frequency setting rolling off at a slope of 12 dB per octave.

**HF and LF Filter Side-Chain**
Using an External Key Input for Side-Chain Processing

To use a filtered or unfiltered external key input to trigger dynamics processing:

1. Click the Key Input selector and select the input or bus carrying the audio from the reference track or external audio source.

2. Click External Key to activate external side-chain processing.

3. To listen to the signal that will be used to control side-chain input, click Side-Chain Listen to enable it (highlighted).

4. To filter the key input so that only specific frequencies trigger the plug-in, use the HF and LF controls to select the desired frequency range.

5. Begin playback. The plug-in uses the input or bus that you chose as an external key input to trigger its effect.

6. Adjust the plug-in’s Threshold (Thresh) control to fine-tune external key input triggering.

7. Adjust other controls to achieve the desired effect.

Using a Filtered Input Signal for Side-Chain Processing

To use the filtered input signal to trigger dynamics processing:

1. Ensure the Key Input selector is set to No Key Input.

2. Ensure that the External Key button is disabled (dark gray).

3. To listen to the signal that will be used to control side-chain input, click Side-Chain Listen to enable it (highlighted).

4. To filter the side-chain input so that only specific frequencies within the input signal trigger the plug-in, use the HF and LF controls to select the desired frequency range.

5. Begin playback. The plug-in uses the filtered input signal to trigger dynamics processing.

6. To fine-tune side-chain triggering, adjust the plug-in controls.
The EQ III plug-in provides a high-quality 7 Band, 2–4 Band, or 1 Band EQ for adjusting the frequency spectrum of audio material.

EQ III is available in the following formats:
- 7 Band: TDM, RTAS, and AudioSuite
- 2–4 Band: TDM and RTAS only
- 1 Band: TDM, RTAS, and AudioSuite

EQ III supports all Pro Tools session sample rates: 192 kHz, 176.4 kHz, 96 kHz, 88.2 kHz, 48 kHz, and 44.1 kHz. EQ III operates as a mono, multi-mono, or stereo plug-in.

EQ III can be operated from the following control surfaces:
- Digidesign D-Command
- Digidesign D-Control
- Digidesign ProControl
- Digidesign C|24
- Digidesign Control|24
- Digidesign 003
- Digidesign Digi 002
- Digidesign Command|8
- Mackie HUI-compatible controllers

EQ III has a Frequency Graph display that shows the response curve for the current EQ settings on a two-dimensional graph of frequency and gain. The frequency graph display also lets you modify frequency, gain and Q settings for individual EQ bands by dragging their corresponding points in the graph.

By choosing from the 7 Band, 2–4 Band, or 1 Band versions of the EQ III plug-in, you can use only the number of EQ bands you need for each track, conserving DSP capacity on Pro Tools|HD systems.

**EQ III Configurations**

The EQ III plug-in appears as three separate choices in the plug-in insert pop-up menu and in the AudioSuite menu:
- 1 Band (“1-Band EQ 3”)
- 2–4 Band (“4-Band EQ 3”)
- 7 Band (“7-Band EQ 3”)
1 Band EQ

The 1 Band EQ is available in TDM, RTAS, and AudioSuite formats.

The 1 Band EQ has its own window, with six selectable filter types.

7 Band EQ and 2–4 Band EQ

The 7 Band EQ is available in TDM, RTAS, and AudioSuite formats. The 2–4 Band EQ is available in TDM and RTAS formats only.

The 7 Band EQ and the 2–4 Band EQ share the same window and identical controls, but with the 2–4 Band EQ, a limited number of the seven available bands can be active at the same time.

EQ III Controls

Adjusting EQ III Controls

You can adjust the EQ III plug-in controls by any of the following methods:

Dragging Plug-in Controls

The rotary controls on the EQ III plug-in can be adjusted by dragging over them horizontally or vertically. Dragging up or to the right increments the control. Dragging down or to the left decrements the control.

Typing Control Values

You can enter control values directly by clicking in the corresponding text box, typing a value, and pressing Enter (Windows) or Return (Mac).

Inverting Filter Gain

(Peak EQ Bands Only)

Gain values can be inverted on any Peak EQ band by Shift-clicking its control dot in the Frequency Graph display, or its Gain knob in the plug-in window. This changes a gain boost to a cut (+9 to –9) or a gain cut to a boost (–9 to +9). Gain values cannot be inverted on Notch, High-Pass, Low-Pass, or shelving bands.
Dragg**ng** in the Frequency Graph Display

You can adjust the following by dragging the control points directly in the Frequency Graph display:

**Frequency** Dragging a control point to the right increases the Frequency setting. Dragging a control point to the left decreases the Frequency setting.

**Gain** Dragging a control point up increases the Gain setting. Dragging a control point down decreases the Gain setting.

**Q** Start-dragging (Windows) or Control-dragging (Mac) a control point up increases the Q setting. Start-dragging (Windows) or Control-dragging (Mac) a control point down decreases the Q setting.

---

Resetting Controls to Default Values

You can reset any on-screen control to its default value by Alt-clicking (Windows) or Option-clicking (Mac OS) directly on the control or on its corresponding text box.

Using Band-Pass Mode

You can temporarily set any EQ III control to Band-Pass monitoring mode. Band-Pass mode cuts monitoring frequencies above and below the Frequency setting, leaving a narrow band of mid-range frequencies. It is especially useful for adjusting limited bandwidth in order to solo and fine-tune each individual filter before reverting the control to notch filter or peaking filter type operations.

💡 *Band-Pass mode does not affect EQ III Gain controls.*

To switch an EQ III control to Band-Pass mode:

- Hold Start+Shift (Windows) or Control+Shift (Mac), and drag any rotary control or control point horizontally or vertically.

---

Adjusting Controls with Fine Resolution

Controls and control points can be adjusted with fine resolution by holding the Control key (Windows) or the Command key (Mac) while adjusting the control.

---

EQ III interactive graph displaying Band-Pass mode

When monitoring in Band-Pass mode, the Frequency and Q controls function differently.

**Frequency** Sets the frequency above and below which other frequencies are cut off, leaving a narrow band of mid-range frequencies.
Q Sets the width of the narrow band of mid-range frequencies centered around the Frequency setting.

To switch an EQ III control out of Band-Pass mode:
- Release Start+Shift (Windows) or Control+Shift (Mac).

Using a Control Surface

EQ III can be controlled from any supported control surface, including Digidesign’s D-Control, D-Command, ProControl, C|24, 003, Digi 002, or Command|8. Refer to the guide that came with the control surface for details.

I/O Controls

The following Input and Output controls are found on all EQ III configurations, except where noted otherwise.

Input Gain Control

The Input Gain control sets the input gain of the plug-in before EQ processing, letting you make up gain or prevent clipping at the plug-in input stage.

Output Gain Control

(7 Band EQ and 2–4 Band EQ Only)

The Output Gain control sets the output gain after EQ processing, letting you make up gain or prevent clipping on the channel where the plug-in is being used.

Input Polarity Control

The Input Polarity button inverts the polarity of the input signal, to help compensate for phase anomalies occurring in multi-microphone environments, or because of mis-wired balanced connections.

Input and Output Meters

(7 Band EQ and 2–4 Band EQ Only)

The plasma-style Input and Output meters show peak signal levels before and after EQ processing, and indicate them as follows:

Green Indicates nominal levels

Yellow Indicates pre-clipping levels, starting at –6 dB below full scale

Red Indicates full scale levels (clipping)

When using the stereo version of EQ III, the Input and Output meters display the sum of the left and right channels.

The Clip indicators at the far right of each meter indicate clipping at the input or output stage of the plug-in. Clip indicators can be cleared by clicking the indicator.
EQ Band Controls

The individual EQ bands on each EQ III configuration have some combination of the following controls, as noted below.

**EQ Type Selector**

On the 1 Band EQ, the EQ Type selector lets you choose any one of six available filter types: High-Pass, Notch, High-Shelf, Low-Shelf, Peak, and Low-Pass.

On the 7 Band EQ and the 2–4 Band EQ, the HPF, LPF, LF, and HF sections have EQ Type selectors to toggle between the two available filter types in each section.

**Band Enable Button**

(7 Band EQ and 2–4 Band EQ Only)

The Band Enable button on each EQ band toggles the corresponding band in and out of circuit. When a Band Enable button is highlighted, the band is in circuit. When a Band Enable button is dark gray, the band is bypassed and available for activation. On the 2–4 Band EQ, when a Band Enable button is light gray, the band is bypassed and unavailable.

**Band Gain Control**

Each Peak and Shelf EQ band has a Gain control for boosting or cutting the corresponding frequencies. Gain controls are not used on High-Pass, Low-Pass, or Notch filters.

**Frequency Control**

Each EQ band has a Frequency control that sets the center frequency (Peak, Shelf and Notch EQs) or the cutoff frequency (High-Pass and Low-Pass filters) for that band.

**Q Control**

Peak and Notch

On Peak and Notch bands, the Q control changes the width of the EQ band. Higher Q values represent narrower bandwidths. Lower Q values represent wider bandwidths.

Shelf

On Shelf bands, the Q control changes the Q of the shelving filter. Higher Q values represent steeper shelving curves. Lower Q values represent broader shelving curves.

Band Pass

On High-Pass and Low-Pass bands, the Q control lets you select from any of the following Slope values: 6 dB, 12 dB, 18 dB, or 24 dB per octave.
Frequency Graph Display
(7 Band EQ and 2–4 Band EQ Only)

The Frequency Graph display in the 7 Band EQ and the 2–4 Band EQ shows a color-coded control dot that corresponds to the color of the Gain control for each band. The filter shape of each band is similarly color-coded. The white frequency response curve shows the contribution of each of the enabled filters to the overall EQ curve.
7 Band EQ

High-Pass/Low Notch

The 7 Band EQ has the following available bands: High-Pass/Low Notch, Low-Pass/High Notch, Low Shelf/Low Peak, Low-Mid Peak, Mid Peak, High-Mid Peak, and High Shelf/High Peak.

All seven bands are available for simultaneous use. In the factory default setting, the High-Pass/Low Notch and Low-Pass/High Notch bands are out of circuit, the Low Shelf and High Shelf bands are selected and in circuit, and the Low-Mid Peak, Mid Peak, High-Mid Peak bands are in circuit.
The High-Pass/Notch band is switchable between high-pass filter and notch EQ functions. By default, this band is set to High-Pass Filter.

**High-Pass Filter** Attenuates all frequencies below the Frequency setting at the selected slope while letting all frequencies above pass through.

**Low-Notch EQ** Attenuates a narrow band of frequencies centered around the Frequency setting. The width of the attenuated band is determined by the Q setting.

The High Pass and Low Notch controls and their corresponding graph elements are displayed on-screen in gray.

### High-Pass Filter and Low Notch EQ control values

<table>
<thead>
<tr>
<th>Control</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency Range</td>
<td>20 Hz to 8 kHz</td>
</tr>
<tr>
<td>Frequency Default</td>
<td>20 Hz</td>
</tr>
<tr>
<td>HPF Slope Values</td>
<td>6, 12, 18, or 24 dB/oct</td>
</tr>
<tr>
<td>Low Notch Q Range</td>
<td>0.1 to 10.0</td>
</tr>
<tr>
<td>Low Notch Q Default</td>
<td>1.0</td>
</tr>
</tbody>
</table>

### Low-Pass/High Notch

The Low-Pass/Notch band is switchable between low-pass filter and notch EQ functions. By default, this band is set to Low-Pass Filter.

**Low-Pass Filter** Attenuates all frequencies above the Frequency setting at the selected slope while letting all frequencies below pass through.

**High-Notch EQ** Attenuates a narrow band of frequencies centered around the Frequency setting. The width of the attenuated band is determined by the Q setting.

The Low Pass and High Notch controls and their corresponding graph elements are displayed on-screen in gray.

### Low-Pass Filter and High Notch EQ control values

<table>
<thead>
<tr>
<th>Control</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency Range</td>
<td>120 Hz to 20 kHz</td>
</tr>
<tr>
<td>Frequency Default</td>
<td>20 kHz</td>
</tr>
<tr>
<td>LPF Slope Values</td>
<td>6, 12, 18, or 24 dB/oct</td>
</tr>
<tr>
<td>High Notch Q Range</td>
<td>0.1 to 10.0</td>
</tr>
<tr>
<td>High Notch Q Default</td>
<td>1.0</td>
</tr>
</tbody>
</table>
**Low Shelf/Low Peak**

The Low Shelf/Peak band is switchable between low shelf EQ and low peak EQ functions. By default, this band is set to Low Shelf.

**Low-Shelf EQ** Boosts or cuts frequencies at and below the Frequency setting. The amount of boost or cut is determined by the Gain setting. The Q setting determines the shape of the shelving curve.

**Low Peak EQ** Boosts or cuts a band of frequencies centered around the Frequency setting. The width of the affected band is determined by the Q setting.

**Low Shelf EQ and Low Peak EQ control values**

<table>
<thead>
<tr>
<th>Control</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency Range</td>
<td>20 Hz to 500 Hz</td>
</tr>
<tr>
<td>Frequency Default</td>
<td>100 Hz</td>
</tr>
<tr>
<td>Low Shelf Q Range</td>
<td>0.1 to 2.0</td>
</tr>
<tr>
<td>Low Peak Q Range</td>
<td>0.1 to 10.0</td>
</tr>
<tr>
<td>Q Default</td>
<td>1.0</td>
</tr>
<tr>
<td>Low Shelf Gain Range</td>
<td>–12 dB to +12 dB</td>
</tr>
<tr>
<td>Low Peak Gain Range</td>
<td>–18 dB to +18 dB</td>
</tr>
</tbody>
</table>
Low-Mid Peak

The Low-Mid Peak band boosts or cuts frequencies centered around the Frequency setting. The width of the band is determined by the Q setting.

Low-Mid Peak EQ

The Low-Mid Gain control and its corresponding graph elements are displayed on-screen in brown.

Low-Mid Peak EQ control values

<table>
<thead>
<tr>
<th>Control</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency Range</td>
<td>40 Hz to 1 kHz</td>
</tr>
<tr>
<td>Frequency Default</td>
<td>200 Hz</td>
</tr>
<tr>
<td>Low-Mid Peak Q Range</td>
<td>0.1 to 10.0</td>
</tr>
<tr>
<td>Low-Mid Peak Q Default</td>
<td>1.0</td>
</tr>
<tr>
<td>Low-Mid Peak Gain Range</td>
<td>–18 dB to +18 dB</td>
</tr>
</tbody>
</table>

Mid Peak

The Mid Peak band boosts or cuts frequencies centered around the Frequency setting. The width of the band is determined by the Q setting.

Mid Peak EQ

The Mid Gain control and its corresponding graph elements are displayed on-screen in yellow.

Mid Peak EQ control values

<table>
<thead>
<tr>
<th>Control</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency Range</td>
<td>125 Hz to 8 kHz</td>
</tr>
<tr>
<td>Frequency Default</td>
<td>1 kHz</td>
</tr>
<tr>
<td>Mid Peak Q Range</td>
<td>0.1 to 10.0</td>
</tr>
<tr>
<td>Mid Peak Q Default</td>
<td>1.0</td>
</tr>
<tr>
<td>Mid Peak Gain Range</td>
<td>–18 dB to +18 dB</td>
</tr>
</tbody>
</table>
High-Mid Peak

The High-Mid Peak band boosts or cuts frequencies centered around the Frequency setting. The width of the band is determined by the Q setting.

High Shelf/High Peak

The High Shelf/Peak band is switchable between high shelf EQ and high peak EQ functions. By default, this band is set to High Shelf.

High-Shelf EQ

Boosts or cuts frequencies at and above the Frequency setting. The amount of boost or cut is determined by the Gain setting. The Q setting determines the shape of the shelving curve.

High Peak EQ

Boosts or cuts a band of frequencies centered around the Frequency setting. The width of the affected band is determined by the Q setting.

High-Mid Peak EQ

The High-Mid Gain control and its corresponding graph elements are displayed on-screen in green.

High-Mid Peak EQ control values

<table>
<thead>
<tr>
<th>Control</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency Range</td>
<td>200 Hz to 18 kHz</td>
</tr>
<tr>
<td>Frequency Default</td>
<td>2 kHz</td>
</tr>
<tr>
<td>Mid Peak Q Range</td>
<td>0.1 to 10.0</td>
</tr>
<tr>
<td>Mid Peak Q Default</td>
<td>1.0</td>
</tr>
<tr>
<td>Mid Peak Gain Range</td>
<td>-18 dB to +18 dB</td>
</tr>
</tbody>
</table>
The High Shelf and High Peak Gain controls and their corresponding graph elements are displayed on-screen in blue.

**High Shelf EQ and High Peak EQ control values**

<table>
<thead>
<tr>
<th>Control</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency Range</td>
<td>1.8 kHz to 20 kHz</td>
</tr>
<tr>
<td>Frequency Default</td>
<td>6 kHz</td>
</tr>
<tr>
<td>High Shelf Q Range</td>
<td>0.1 to 2.0</td>
</tr>
<tr>
<td>High Peak Q Range</td>
<td>0.1 to 10.0</td>
</tr>
<tr>
<td>Q Default</td>
<td>1.0</td>
</tr>
<tr>
<td>High Shelf Gain Range</td>
<td>–12 dB to +12 dB</td>
</tr>
<tr>
<td>High Peak Gain Range</td>
<td>–18 dB to +18 dB</td>
</tr>
</tbody>
</table>

**2–4 Band EQ**

The 2–4 Band EQ uses the same plug-in window as the 7 Band EQ, but on the 2–4 Band EQ, but a limited number of the seven available bands can be active at the same time.

In the factory default setting, the High-Pass/Low Notch, Low-Pass/High Notch and Mid Peak bands are out of circuit, the Low Shelf and High Shelf bands are selected and in circuit, and the Low-Mid Peak and High-Mid Peak bands are in circuit.

For Pro Tools HD, using a 2–4 Band EQ instead of a 7 Band EQ saves DSP resources.

**Changing from 2–4 Band to 7 Band**

After switching from a 2–4 band EQ to a 7 Band EQ, or importing settings from a 2–4 Band EQ, all control settings from the 2–4 Band EQ are preserved, and the bands in the 7 Band EQ inherit their enabled or bypassed state from the 2–4 Band plug-in.

Additional EQ bands can then be enabled to add them to the settings inherited from the 2–4 Band plug-in.

**Filter Usage with 2–4 Band EQs**

With a 2–4 Band EQ, a maximum of four filters may be active simultaneously, with each of the five Peak bands (Low Shelf/Peak, Low-Mid Peak, Mid-Peak, High-Mid Peak and High Shelf/Peak) counting as one filter. Each of the Band-pass and Notch filters (High-Pass, Low Notch, Low-Pass and High-Notch) counts as two filters.

When any combination of these filter types uses the four-filter maximum on the 2–4 Band EQ, the remaining bands become unavailable. This is indicated by the Band Enable buttons turning light gray. When filters become available again, the Band Enable button on inactive bands turns dark gray.

**Switching Between the 2–4 Band EQ and 7 Band EQ**

When you switch an existing EQ III plug-in between the 2–4 Band and 7 Band versions, or when you import settings between versions, the change is subject to the following conditions:

**Changing from 7 Band to 2–4 Band**

After switching from a 7 band EQ to a 2–4 Band EQ, or importing settings from a 7 Band EQ, all control settings from the 7 Band EQ are preserved in the 2–4 Band EQ, but all bands are placed in a bypassed state.

Bands can then be enabled manually, up to the 2–4 Band EQ four-filter limit.
1 Band EQ

The Frequency Graph display in the 1 Band EQ shows a control dot that indicates the center frequency (Peak, Shelf and Notch Filters) or the cutoff frequency (High-Pass and Low-Pass filters) for the currently selected filter type.

Band Controls

The individual EQ types have some combination of the following controls, as noted below.

1 Band EQ control values

<table>
<thead>
<tr>
<th>Control</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency Range (All)</td>
<td>20 Hz to 20 kHz</td>
</tr>
<tr>
<td>Frequency Default (All)</td>
<td>1 kHz</td>
</tr>
<tr>
<td>Q Range (Low/High Shelf)</td>
<td>0.1 to 2.0</td>
</tr>
<tr>
<td>Q Range (Peak/Notch)</td>
<td>0.1 to 10.0</td>
</tr>
<tr>
<td>Q Default (All)</td>
<td>1.0</td>
</tr>
<tr>
<td>Gain Range (Low/High Shelf)</td>
<td>–12 dB to +12 dB</td>
</tr>
<tr>
<td>High Peak Gain Range</td>
<td>–18 dB to +18 dB</td>
</tr>
</tbody>
</table>

EQ Types

High-Pass Filter

The High-Pass filter attenuates all frequencies below the Frequency setting at the selected rate (6 dB, 12 dB, 18 dB, or 24 dB per octave) while letting all frequencies above pass through. No gain control is available for this filter type.

The 1 Band EQ may be set to any one of six EQ types: High-Pass, Notch, High-Shelf, Low-Shelf, Peak, and Low-Pass, by clicking the corresponding icon in the EQ Type selector.
**Notch Filter**

The Notch Filter attenuates a narrow band of frequencies centered around the Frequency setting. No gain control is available for this EQ type. The width of the attenuated band is determined by the Q setting.

**High-Shelf EQ**

The High-Shelf EQ boosts or cuts frequencies at and above the Frequency setting. The amount of boost or cut is determined by the Gain setting. The Q setting determines the shape of the shelving curve.

**Low-Shelf EQ**

The Low-Shelf EQ boosts or cuts frequencies at and below the Frequency setting. The amount of boost or cut is determined by the Gain setting. The Q setting determines the shape of the shelving curve.

**Peak EQ**

The Peak EQ boosts or cuts a band of frequencies centered around the Frequency setting. The width of the affected band is determined by the Q setting.
Low-Pass Filter

The Low-Pass filter attenuates all frequencies above the cutoff frequency setting at the selected rate (6 dB, 12 dB, 18 dB, or 24 dB per octave) while letting all frequencies below pass through. No gain control is available for this filter type.

1 Band EQ set to Low-Pass Filter
There are six different Mod Delay II plug-ins, capable of different maximum delay times:

- The AudioSuite only version of the Delay plug-in provides up to 10.9 seconds of delay at all sample rates.
- The Short Delay provides 43 ms of delay at all sample rates.
- The Slap Delay provides 171 ms of delay at all sample rates.
- The Medium Delay provides 341 ms of delay at all sample rates.
- The Long Delay provides 683 ms of delay at all sample rates.
- The Extra Long Delay provides 2.73 seconds of delay at all sample rates.

⚠️ *Short Delay and Slap Delay do not have Tempo, Meter, Duration, and Groove controls.*

- The Medium Delay provides 341 ms of delay at all sample rates.
- The Long Delay provides 683 ms of delay at all sample rates.
- The Extra Long Delay provides 2.73 seconds of delay at all sample rates.

⚠️ *The TDM versions of the Extra Long Delay mono-to-stereo and stereo plug-in are not supported at 96 kHz. All TDM versions of the Extra Long Delay plug-in are not supported at 192 kHz. RTAS versions of the Extra Long Delay plug-in are fully supported at all sample rates.*

**Mod Delay II Controls**

- **Input** Controls the input volume of the delay to prevent clipping.
- **Mix** Controls the balance between the delayed signal (wet) and the original signal (dry). If you are using a delay for flanging or chorusing, you can control the depth of the effect somewhat with the Mix setting.
**LPF (Low-Pass Filter)** Controls the cutoff frequency of the Low-Pass Filter. Use the LPF setting to attenuate the high frequency content of the feedback signal. The lower the setting, the more high frequencies are attenuated. The maximum value for LPF is Off. This lets the signal pass through without limiting the bandwidth of the plug-in.

**Delay** Sets the delay time between the original signal and the delayed signal.

**Depth** Controls the depth of the modulation applied to the delayed signal.

**Rate** Controls the rate of modulation of the delayed signal.

**Feedback** Controls the amount of feedback applied from the output of the delay back into its input. It also controls the number of repetitions of the delayed signal. Negative feedback settings give a more intense “tunnel-like” sound to flanging effects.

**Tempo Sync** Provides a direct connection between the Pro Tools session tempo and plug-in controls that support MIDI Beat Clock (such as Delay). This direct connection lets plug-in parameters such as delay, automatically synchronize to, and follow changes in, session tempo.

When Tempo Sync is enabled, the Tempo and Meter controls are uneditable and follow the session tempo and meter changes. The Duration and Groove controls apply when Tempo Sync is enabled.

**To enable Tempo Sync:**

- Click the Tempo Sync icon. The tempo shown changes to match the current session tempo and the meter changes to match the current meter.

**Tempo Sync icon**

**Tempo** Selects the desired tempo in beats per minute (bpm). This setting is independent of Pro Tools’ tempo. When a specific Duration is selected (see “Duration” below), moving this control affects the Delay setting. Likewise, the range of both controls will be limited to the maximum available delay with the currently selected Duration. To enter very short or long delays it may be necessary to deselect all Duration buttons.

When Tempo Sync is enabled, the Tempo control is unavailable.

**Meter** Use this to enter either simple or compound time signatures. The Meter control defaults to a 4/4 time signature.

When Tempo Sync is enabled, the Meter control is unavailable.
Duration  Specifies a desired delay from a musical perspective. Enter the desired delay by selecting appropriate note value (whole note, half note, quarter note, eight note, or sixteenth note). Select the Dot or Triplet modifier buttons to dot the selected note value or make it a triplet. For example, selecting a quarter note and then selecting the dot indicates a dotted quarter note, and selecting an eighth note and then selecting the triplet indicates a triplet eight note.

Groove  Provides fine adjustment of the delay in percentages of a 1:4 subdivision of the beat. It can be used to add “swing” by slightly offsetting the delay from the precise beat of the track.

⚠️ It is not possible to exceed the maximum delay length for a particular version of Mod Delay II. Consequently, when adjusting any of the tempo controls (Tempo, Meter, Duration, and Groove) you may not be able to adjust the control across its full range. If you encounter this behavior, switch to a version of Mod Delay II that has a longer delay time (for example, switch from Medium Delay to Long Delay).

Multichannel Mod Delay II

The Tempo and Meter controls are linked on multichannel versions of Mod Delay II. Each channel has its own Duration and Groove controls, but the Tempo and Meter controls are global.

Selections for ModDelay II

AudioSuite Processing

Because AudioSuite Delay adds additional material (the delayed audio) to the end of selected audio, make a selection that is longer than the original source material to allow the additional delayed audio to be written into the end of the audio file.

Selecting only the original material, without leaving additional space at the end, will cause delayed audio that occurs after the end of the region to be cut off.
The Pitch plug-in is designed for a variety of audio production applications ranging from pitch correction of musical material to sound design.

Pitch processing uses the technique of varying sample playback rate to achieve pitch transposition. Because changing audio sample playback rate results in the digital equivalent of vari-speeding with tape, this is an unsatisfactory method since it changes the overall duration of the material.

Pitch transposition with the Pitch plug-in involves a much more complex technique: digitally adding or subtracting portions of the audio waveform itself, while using de-glitching cross-fades to minimize undesirable artifacts. The result is a processed signal that is transposed in pitch, but still retains the same overall length as the original, unprocessed signal.

💡 The Pitch plug-in was formerly called DPP-1. It is fully compatible with all settings and presets created for DPP-1.

**Pitch Controls**

- **Input Level** Attenuates the input level of the Pitch plug-in to help prevent internal clipping.

- **Signal Present Indicator LED** Indicates the presence of an input signal.

- **Clip Indicator** Indicates whether clipping has occurred on output. It is a clip-hold indicator. If clipping occurs at any time, the clip light will remain on. To clear the Clip indicator, click it. Long delay times and high feedback times increase the likelihood of clipping.
**Mix** Adjusts the ratio of dry signal to effected signal in the output. In general, this control should be set to 100% wet, unless you are using the Pitch plug-in in-line on an Insert for an individual track or element in a mix. This control can be adjusted over its entire range with little or no change in output level.

**Delay** Sets the delay time between the original signal and the pitch-shifted signal. It has a maximum setting of 125 milliseconds. You can use the Delay control in conjunction with the Feedback control to generate a single pitch-shifted echo, or a series of echoes that climb in pitch.

**Feedback** Controls the amount and type of feedback (positive or negative) applied from the output of the delay portion of the Pitch plug-in back into its input. It also controls the number of repetitions of the delayed signal. You can use it to produce effects that spiral up or down in pitch, with each successive echo shifted in pitch.

**Coarse** Adjusts the pitch of a signal in semitones over a two octave range. Pitch changes are indicated both in the Semitones field and in the Musical Staff section below this slider. Using the –8va and +8va buttons in conjunction with the Coarse slider provides a full 4-octave range of adjustment.

**–8va and +8va Buttons** Clicking the –8va button adjusts pitch down one octave from the current setting of the coarse and fine pitch controls. Clicking the +8va button adjusts pitch up one octave from the current setting of the coarse and fine pitch controls.

**Relative Pitch Entry (Musical Staff)**

Clicking on any note on this musical staff selects a relative pitch transposition value that will be applied to an audio signal. If the C above middle C is illuminated (the staff is in treble clef), it indicates that no pitch transposition has been selected. If a pitch transposition is selected, the note interval corresponding to the selected transposition value is indicated in yellow. Alt-clicking (Windows) or Option-clicking (Mac) on the staff will set the coarse pitch change value to zero.

**Fine** Controls the pitch of a signal in cents (hundredths of a semitone) over a 100 cent range. The range of this slider is –49 to +50 cents. Precise pitch change values are indicated in the Fine field. The flat, natural, and sharp signs below this slider indicate deviation from the nearest semitone.

**Ratio** Indicates the ratio of transposition between the original pitch and the selected transposition value.

**Crossfade** Adjusts crossfade length in milliseconds to optimize performance of the Pitch plug-in according to the type of audio material you are processing. The Pitch plug-in performs pitch transposition by replicating or subtracting portions of audio material and very quickly cross-fading between these alterations in the waveform of the audio material.

Crossfade length affects the amount of smoothing performed on audio material to prevent audio artifacts such as clicks from occurring as the audio is looped to generate the pitch shift.
In general, small, narrow-range pitch shifts require longer crossfades and large shifts require smaller ones. The disadvantage of a long crossfade time is that it will smooth the signal, including any transients. While this is sometimes desirable for audio material such as vocals, it is not appropriate for material with sharp transients such as drums or percussion.

The default setting for this control is Auto. At this setting, crossfade times are set automatically, according to the settings of the Coarse and Fine pitch controls. The Auto setting is appropriate for most applications. However, you can manually adjust and optimize crossfade times using the Crossfade slider if necessary. For audio material with sharper attack transients, use shorter crossfade times. For audio material with softer attack transients, use longer crossfade times.

**Minimum Pitch** Sets the minimum fundamental pitch that the Pitch plug-in will recognize when performing pitch transposition. Use this to optimize the Pitch plug-in’s performance by adjusting this control based on the lowest fundamental pitch of the audio material that you want to process.

On audio material with a low fundamental pitch frequency content (such as an electric bass) setting this control to a lower frequency (such as 30 Hz) will improve the Pitch plug-in’s performance. The most important thing to remember when using this control is that the fundamental frequency of audio material you want to process must be above the frequency you set here.

The range of this slider is from 15 Hz to 1000 Hz. The default setting is 60 Hz. Adjustment is tied to the current setting of the Maximum Pitch control so that the minimum range is never less than one octave, and the maximum range never more than five octaves.

**Maximum Pitch** Adjusts the maximum fundamental pitch that the Pitch plug-in will recognize when performing pitch transposition. To optimize the Pitch plug-in’s performance, adjust this setting (and the Minimum Pitch setting) based on the highest fundamental pitch of the audio material that you want to process. The range of this slider is from 30 Hz to 4000 Hz. The default setting is 240 Hz.
Chapter 10

Pitch Shift

(AudioSuite Only)

The Pitch Shift plug-in adjusts the pitch of any source audio file with or without a change in its duration. This is a very powerful function that transposes audio a full octave up or down in pitch with or without altering playback speed.

Gain Adjusts input level, in 10ths of a dB. Dragging the slider to the right increases gain, dragging to the left decreases gain.

Coarse and Fine Adjusts amount of pitch shift. The Coarse slider transposes in semitones (half steps). The Fine slider transposes in cents (hundredths of a semitone).

Time Correction Disabling this option has the effect of “permanently varispeeding” your audio file. The file’s duration will be compressed or extended according to the settings of the Coarse and Fine pitch controls. When Time Correction is enabled, fidelity can be affected. For example, time expansion as a result of Time Correction when lowering pitch can cause the audio to sound granulated.

Ratio Adjusts the amount of transposition (pitch change). Moving the slider to the right raises the pitch of the processed file, while moving the slider to the left decreases its pitch.

Crossfade Use this to manually adjust crossfade length in milliseconds to optimize performance of the Pitch Shift plug-in according to the type of audio material you are processing. This plug-in achieves pitch transposition by processing very small portions of the selected audio material and very quickly crossfading between these alterations in the waveform of the audio material.

Crossfade length affects the amount of smoothing performed on audio material. This prevents audio artifacts such as clicks from occurring. In general, smaller pitch transpositions require longer crossfades; wider pitch transpositions require smaller crossfades. Long crossfade times may over-smooth a signal and its transients. This is may not be desirable on drums and other material with sharp transients.
Use the Crossfade slider to adjust and optimize crossfade times. For audio material with sharper attack transients, use smaller crossfade times. For audio material with softer attack transients, use longer crossfade times.

**Min Pitch** Sets the lowest pitch used in the plug-in’s Pitch Shift processing. The control has a range of 40 Hz to 1000 Hz. Use it to focus the Pitch Shift process according to the audio’s spectral shape.

Use lower values when processing lower frequency audio material. Use higher values when processing higher frequency audio material.

**Accuracy** Sets the processing resources allocated to audio quality (Sound) or timing (Rhythm). Set the slider toward Sound for better audio quality and fewer audio artifacts. Set the slider toward Rhythm for a more consistent tempo.

**Reference Pitch** Activates a sine wave-based pitch generator that you can use as an audible reference when pitch-shifting audio material.

**Note** Adjusts the frequency of the reference tone in semitones (half steps).

**Detune** Provides finer adjustment of the frequency of the reference tone in cents (100ths of a semitone).

**Gain** Adjusts the volume of the reference tone in dB.

---

**To use the Reference Pitch:**

1. Select the audio material you want to use as a pitch reference. Click the preview button to begin playback of the selected audio.

2. Click the Reference Pitch button to activate the reference sine wave tone.

3. Adjust the Note and Detune settings to match the reference tone to the pitch of the audio playback. Adjust the Gain setting to change the relative volume of the reference tone. It may also be helpful to toggle the Reference Pitch on and off to compare pitch.

4. Select the audio material to be pitch shifted.

5. Adjust the Coarse and Fine Pitch Shift controls to match the pitch of the audio playback to the reference pitch.

6. Click Process to apply pitch shift to the selection.
POW-r Dither

(TDM and RTAS, Pro Tools HD and Pro Tools LE Only)

The POW-r Dither plug-in is an advanced type of dither that provides optimized bit depth reduction. It is designed for final-stage critical mixdown and mastering tasks where the highest possible fidelity is desired when reducing bit depth. For more information on dithering, see Chapter 4, “Dither.”

POW-r Dither Controls

Bit Resolution

Use this pop-up menu to choose either 16- or 20-bit resolutions for POW-r Dither processing. Set this control to the maximum bit resolution of your destination.

16-bit Recommended for output to digital devices with a maximum resolution of 16 bits, such as DAT and CD recorders.

20-bit Recommended for output to devices that support a full 20-bit recording data path.

Noise Shaping

Noise shaping can further improve audio performance and reduce perceived noise inherent in dithered audio. Noise shaping uses filtering to shift noise away from frequencies in the middle of the audio spectrum (around 4 kHz), where the human ear is most sensitive.

⚠️ The POW-r Dither plug-in is not appropriate for truncation stages that are likely to be further processed. It is recommended that POW-r Dither be used only as the last insert in the signal chain (especially when using Type 1 Noise Shaping).
The POW-r Dither plug-in provides three types of noise shaping, each with its own characteristics. Try each noise shaping type and choose the one that adds the least amount of coloration to the audio being processed.

**Type 1** Has the flattest frequency spectrum in the audible range of frequencies, modulating and accumulating the dither noise just below the Nyquist frequency. Recommended for less stereophonically complex material such as solo instrument recordings.

**Type 2** Has a psychoacoustically optimized low order noise shaping curve. Recommended for material of greater stereophonic complexity.

**Type 3** Has a psychoacoustically optimized high order noise shaping curve. Recommended for full-spectrum, wide-stereo field material.

For more information on using Dither, see the Pro Tools Reference Guide.
Chapter 12: ReWire

ReWire

(RTAS Only)

Pro Tools supports ReWire version 2.0 technology developed by Propellerheads Software. ReWire is available using the DigiRack ReWire RTAS plug-in.

ReWire provides real-time audio and MIDI streaming between applications, with sample-accurate synchronization and common transport functionality.

Compatible ReWire client applications are automatically detected by Pro Tools and are available in the RTAS Plug-ins Insert menus in Pro Tools. Selecting a ReWire client application within Pro Tools automatically launches that application (if the client application supports this feature). Any corresponding MIDI nodes for that application are available in any Instrument track’s MIDI Output selector (Instrument view) and any MIDI track’s Output selector.

⚠️ Not all ReWire client applications support automatic launch from a ReWire-mixer application. For these applications, launch the ReWire client application separately, and then select it as a plug-in insert in Pro Tools.

Once the outputs of your software synthesizers and samplers are routed to Pro Tools, you can:

- Process incoming audio signals with plug-ins
- Automate volume, pan, and plug-in controls
- Bounce To Disk
- Take advantage of the audio outputs of your Digidesign audio interfaces

⚠️ Exchange of additional metadata such as controller and note names between Pro Tools and ReWire clients is not supported.

Pro Tools does not support sending audio to ReWire client applications.
Figure 1. Audio and MIDI signal flow between Pro Tools and a ReWire client application (Reason shown)
ReWire Requirements

To use the ReWire plug-in, you will need:

- A Digidesign-qualified Pro Tools system
- ReWire-compatible client software (such as Reason from Propellerheads Software)

⚠️ Client software must support the same sample rate as the session using ReWire. For example, third-party client software that does not support sample rates beyond 48 kHz cannot be used in 96 kHz Pro Tools sessions.

ReWire support is also under development for other third-party companies. For availability, check with the manufacturer or visit the Digidesign website (www.digidesign.com).

ReWire and Track Count with Pro Tools HD

With Pro Tools HD, the ReWire RTAS plug-in can be inserted on any kind of track. Each channel of audio transmitted through ReWire then uses the same amount of resources as the audio track on which it is inserted.

Consequently, you can only use a total combination of audio tracks and ReWire audio streams that does not exceed the maximum number of possible voices for your system. For example, if you are playing 40 audio tracks in a 48 kHz/24-bit session on a 128-voice Pro Tools|HD 2 system, that will leave 88 channels of audio (88 mono, or 44 stereo) available for use with ReWire. (However, ReWire only supports a maximum of 64 audio streams per application.)

Using ReWire at higher sample rates will increase the load on the CPU. For example, CPU load at 96 kHz is double the load at 48 kHz. You can monitor Pro Tools CPU usage in the System Usage window, making sure to not overtax your system.

💡 With Pro Tools HD, the standard Hardware Buffer size of 512 samples is strongly recommended for using ReWire in sessions with sample rates above 48 kHz.

ReWire and Track Count with Pro Tools LE

With Pro Tools LE, performance is determined by several factors, including host CPU speed, available memory, and buffer settings. Digidesign cannot guarantee 64 simultaneous audio channel outputs with ReWire on all computer configurations.

For the latest information on recommended CPUs and system configurations, visit the Digidesign website (www.digidesign.com).
Using ReWire

The ReWire plug-in is installed when you install Pro Tools. All inter-application communications between Pro Tools and ReWire client software is handled automatically.

To use a ReWire client application with Pro Tools:

1. Make sure that the ReWire client application is installed properly and that you have restarted your computer.

2. In Pro Tools, choose Track > New and specify one Instrument track (or audio or Auxiliary Input track), and click Create.

3. In the Mix window, click the Insert selector on the track and assign the ReWire RTAS client plug-in to the track insert.

The ReWire client application launches automatically in the background (if the client application supports auto-launch).

4. Configure the ReWire client application to play the sounds you want.

5. In Pro Tools, set the output of the client application in the ReWire plug-in window. This is the audio output of the ReWire client to Pro Tools.

Selecting the audio output from a ReWire client

6. In the Mix window, click the track’s MIDI Output selector and select the ReWire client application. Some ReWire clients (such as Reason) may list multiple devices. If so, choose the device that you want.

Selecting the ReWire client device to receive MIDI from Pro Tools

7. Choose Options > MIDI Thru and record enable the MIDI track. Play some notes on your MIDI controller to trigger the client application.

The selected ReWire device responds to MIDI sent from Pro Tools and plays back audio through the assigned Pro Tools track (Instrument, Auxiliary Input, or audio track).
If your ReWire client application is a sequencer and you want to begin synchronized playback with Pro Tools, press the Spacebar or click the Play button on the Pro Tools Transport.

⚠️ If you experience system performance problems while using Pro Tools with ReWire client applications, you may need to increase the Pro Tools CPU Usage Limit. See “CPU Usage Limit” on page 11 for instructions.

MIDI Automation with ReWire

You can use Pro Tools MIDI tracks to record MIDI continuous controller (CC) data from a ReWire client application, and then play back MIDI from Pro Tools to send the recorded MIDI CC data back to the ReWire client application. In this way, you can adjust parameters in the ReWire client application (using the mouse or an external MIDI controller) and record those changes in Pro Tools.

Recording MIDI Continuous Controller Data Over ReWire

The first step in automating a ReWire client application’s parameters is to record the CC data to a MIDI track in Pro Tools.

To record MIDI from a ReWire client application in Pro Tools:

1. In Pro Tools, create a new MIDI track.
2. From the track’s MIDI Input selector, select the ReWire device that you want to record.

To record MIDI from a ReWire client application in Pro Tools:

1. In Pro Tools, create a new MIDI track.
2. From the track’s MIDI Input selector, select the ReWire device that you want to record.

3. Record enable the MIDI track.
5. Switch to the ReWire client application.

⚠️ You must select the ReWire device from which you want to record MIDI controller data. Leaving the track’s MIDI Input set to All does not record any MIDI data over Re-Wire.
6 Adjust the parameter for which you want to record MIDI CC data. Parameter changes are recorded to the Pro Tools MIDI track as CC data.

![Adjusting a parameter in a ReWire client application](image1)

- If your external MIDI controller is correctly mapped to the corresponding ReWire client application’s parameters, and it is correctly routed through Pro Tools, use your MIDI controller to adjust the parameter you want to record.

7 When you are done adjusting the parameter, return to Pro Tools and stop recording.

8 Record disable the MIDI track.

9 From the MIDI Track View selector in the Edit window, select the view for the CC data you just recorded.

![MIDI CC data recorded from a ReWire client application](image2)

**Playing Back MIDI Continuous Controller Data Over ReWire**

Once you have recorded MIDI CC data from the ReWire client application to a MIDI track, configure the MIDI track to play the ReWire client application. You can also edit the MIDI CC data in Pro Tools until you achieve the best results.

**To play back MIDI CC data over ReWire:**

1. From the MIDI track’s MIDI Output selector, select the ReWire client application device you want to control (the same device from which you recorded the MIDI CC data).

2. Start playback in Pro Tools.

3. Switch to the ReWire client application. Notice that the corresponding parameter changes according the MIDI CC data from Pro Tools.

**Quitting ReWire Client Applications**

When quitting Pro Tools sessions that integrate ReWire client applications, quit the client application first, then quit Pro Tools.

- If you quit Pro Tools before quitting ReWire client applications, a warning dialog may appear stating that “one or more ReWire applications did not terminate.” To avoid this, quit all ReWire client applications before quitting Pro Tools.
**Tempo and Meter Changes**

Pro Tools transmits both Tempo and Meter data to ReWire client applications, allowing ReWire-compatible sequencers to follow any tempo and meter changes in a Pro Tools session.

With the Pro Tools Conductor button selected, Pro Tools always acts as the Tempo master, using the tempo map defined in its Tempo Ruler.

With the Pro Tools Conductor button deselected, the ReWire client acts as the Tempo master. In both cases, playback can be started or stopped in either application.

⚠️ _Pro Tools supports tempo values from 30–300 bpm. When slaved to a ReWire client application, Pro Tools playback will be restricted to this range even if the client application’s tempo is outside this range. Additionally, some ReWire client applications (such as Reason) may misinterpret Pro Tools meter changes, resulting in mismatched locate points and other unexpected behavior. To prevent this, avoid using meter changes in Pro Tools when using Reason as a ReWire client._

**Looping Playback**

Because Pro Tools does not offer separate loop markers as found in other third party applications such as Reason, if you want to loop playback, do one of the following:

**To loop playback in Pro Tools:**

1. In the Pro Tools Timeline, select the time range that you want to loop.

2. Begin playback by pressing the Spacebar or clicking the Play button in the Transport.

**To loop playback within a ReWire client sequencer**

- With playback stopped, specify the loop within the ReWire client application and begin playback.

⚠️ _If you create a playback loop by making a selection in the Pro Tools Timeline, once playback is started, any changes made to loop or playback markers within the ReWire client application will deselect the Pro Tools Timeline selection and remove the loop._
Automating ReWire Input Switching

ReWire supports automation for switching inputs during playback.

To automate switching inputs during playback:

1. Set the track's automation to write.

2. Do one of the following:
   - Change the input link pop-up menu manually.
   - Draw the automation in the Edit window.

For information on drawing automation, see the Pro Tools Reference Guide.
Chapter 13

Signal Generator

(TDM, RTAS, and AudioSuite)

The Signal Generator plug-in produces audio test tones in a variety of frequencies, waveforms, and amplitudes. It is particularly useful for generating reference signals with which to calibrate Pro Tools|HD interfaces (such as the 192 I/O) and other elements of your studio.

Signal Generator Controls

Frequency Sets the frequency of the signal in hertz. Values range from a low of 20 Hz to a high of 20 kHz in a 44.1 kHz session. The upper limit of the frequency range for this setting will increase to match the Nyquist frequency (half the sample rate) in 96 kHz and 192 kHz sessions (HD-series systems only).

Level Sets the amplitude of the signal in decibels. Values range from a low of –95 dB to a high of 0.0 dB.

Signal These buttons select the waveform. Choices are sine, square, sawtooth, triangle, white noise, and pink noise.

Peak Generates signal at the maximum possible level without clipping.

RMS Generates signal at levels consistent with the RMS (Root-Mean-Square) value, or the effective average level of the signal.

Refer to the Pro Tools|HD Setup Guide for instructions on using Signal Generator to calibrate the 96 I/O, or 192 I/O audio interfaces, as well as older audio interfaces.

The Signal Generator plug-in is not intended for rigorous test purposes; it is a simple level calibration tool.

The TDM Signal Generator produces a tone as soon as it is inserted on a track. To mute the Signal Generator, use the Bypass button. When using the RTAS version of Signal Generator, start playback to generate.
AudioSuite Processing with Signal Generator

To create an audio region using the Signal Generator plug-in:

1. Make a selection in the Edit window.

2. Choose AudioSuite > Signal Generator.

3. Enter values for the Frequency, Level, and Signal controls.

4. Click Process in the Signal Generator plug-in.

💡 Select the Create Continuous File option for greater flexibility in making audio selections for use with the Signal Generator plug-in.

💡 You can use the AudioSuite Signal Generator plug-in for musical purposes as well as for testing purposes. For example, you might want to add a little color to a kick drum track by doubling it with a 50 Hz tone, using the kick track as the key input signal gating the tone track.
DigiRack SignalTools metering plug-ins provide two metering modules:

- SurroundScope
- PhaseScope

The SignalTools plug-ins support TDM and RTAS plug-in formats at all sample rates.

**SurroundScope**

(Pro Tools HD and Pro Tools LE with Complete Production Toolkit Only)

SurroundScope is a plug-in that provides surround metering for multichannel track types from 3 channels (LCR) to 8 channels (7.1 surround). Stereo and mono tracks are not supported.

💡 This version of SurroundScope is compatible with sessions that used the previous versions of SurroundScope.
**Surround Display**

SurroundScope detects the multi-channel format of the track and displays each channel in the signal in a circle around the Surround Display.

*SurroundScope Surround Display (5.0 shown)*

The Surround Display generates a composite image that indicates relative signal strength in the displayed channels.

- A circle in the center of the display indicates a surround signal that is panned equally to all channels.
- An irregular shape that is closer to one side of the display indicates that the channels on that side have a stronger signal.
- A teardrop shape that points toward a single channel indicates that the signal is panned to that channel.

---

**PhaseScope**

*(TDM and RTAS)*

PhaseScope is a multichannel metering plug-in that provides signal level and phase information for stereo tracks only. (Mono and LCR or greater multichannel tracks are not supported.)

*PhaseScope plug-in*
Lissajous Meter Display

The PhaseScope Lissajous Meter displays the relationship between the amplitude and phase of a stereo signal, enabling you to monitor stereo imaging graphically.

A “Lissajous curve” (also known as a Lissajous figure or Bowditch curve) is a type of graph that is able to describe complex harmonic motion. To learn more, search the Web or your local library for information on its origins and its two principal developers, Jules Antoine Lissajous, and Nathaniel Bowditch.

SignalTools Display Options

Both SignalTools plug-ins offer two display options: Phase Meter Display and Leq(A) Meter Display.

To choose a display option:

- Click the corresponding button in the Options section of the plug-in window.

Phase Meter Display

The Phase Meter indicates the phase coherency of two channels of a multi-channel signal.

The Phase Meter is green when the channels are positively out of phase (values from 0 to +1) and red when the channels are negatively out of phase (values from 0 to –1).

At the center or zero position, the signal is a perfect stereo image. At the +1 position, the signal is a perfect mono image. At the –1 position, the signal is 100% out of phase.
**SurroundScope** With SurroundScope you can select the two channels to compare by clicking the channel buttons around the Surround Display. Selected channels are indicated in blue.

![Selecting SurroundScope channels for phase metering](image)

**PhaseScope** With PhaseScope, the left and right channels are always compared.

**Leq(A) Meter Display**

The Leq(A) Meter display lets you view the true weighted average of the power level sent to any channel or combination of channels (except the LFE channel) in a multichannel track.

The Leq(A) Meter display shows a floating average for the level over the interval chosen in the Window menu. For example, with a setting of 2 seconds, the display shows the average value for the most recent 2 seconds of audio playback.

![SignalTools Leq(A) meter and controls](image)

**Selecting Channels for Leq(A) Metering**

**SurroundScope** With SurroundScope, you can select any combination of channels for Leq(A) metering by clicking the channel buttons around the Surround Display. Selected channels are indicated in green.

![Selecting SurroundScope channels for Leq(A) metering](image)

**PhaseScope** With PhaseScope, you can select either or both channel for Leq(A) metering by clicking the channel buttons in the corners of the Lissajous display. Selected channels are indicated in green.

![Selecting PhaseScope channels for Leq(A) metering](image)

**Leq(A) Metering Controls**

**Window** The Leq(A) window menu lets you choose the length of time the signal is measured before an average value is calculated. Settings range from 1 second to 2 minutes.

When the Leq(A) meter is in INF (infinite) mode it is constantly averaging the signal without a floating averaging window.

**Reset** The Reset button lets you manually reset the start time of the Leq(A) measurement window.
**Auto Reset** When enabled, causes the start time of the Leq(A) measurement window to be automatically reset whenever playback starts in Pro Tools.

**Hold on Stop** When enabled, causes the Leq(A) measurement window timer to pause when playback stops, and resume when playback begins again.

*In any of the Loop Transport modes, the measurement start time is automatically reset each time playback goes back to the beginning of the loop.*

---

**SignalTools Level Meters**

The SignalTools plug-ins let you choose the type of metering to use. Each meter type has a different metering scale and response.

---

**Meter Types**

**Peak** (Default meter type) Uses the metering scale in DigiRack EQ III and Dynamics III plug-ins.

**RMS** (Root Mean Square) was used in previous versions of the Digidesign SurroundScope plug-in and uses the same “true” RMS metering scale.

*The “true” RMS meter scale is not the same as the AES 17 RMS scale. For a sine wave with a peak value of –20 dBFS, the “true” RMS meter will show a value of –23 dBFS. (The same sine wave will show a value of –20 dBFS on an AES 17 RMS meter.)*

**Peak + RMS** Uses a multi-color display to show both types of metering. Peak metering is shown in conventional green color, while RMS metering is shown in blue.

**VU** (Volume Unit) Uses AES standards for signal level indication.

**BBC** Uses IEC-IIa standards for signal level indication. This style of metering suppresses short duration peaks that would not affect broadcast program material. Reference calibration (4 dB) is –18 dBFS.

**Nordic** Uses IEC Type I standards for signal level indication and provides greater resolution for readings between –10 dBu and +4 dBu. Reference calibration (0 dB) is –18 dBFS.

**DIN** Uses IEC Type I standards for signal level indication and provides greater resolution for readings between –10 dBu and +5 dBu. Reference calibration (–9 dB) is –18 dBFS.
VENUE Provides Peak metering behavior with a meter scale calibrated specifically for Digidesign VENUE systems. Reference calibration (0 dB) is –20 dBFS.

💡 *Meter values are always displayed on control surfaces in dBFS values, regardless of the Meter Type setting.*

**Meter Peak Hold Options**

Each of the SignalTools plug-ins lets you choose the style of peak hold when peaks are shown in the plug-in meters.

- **3 Sec Hold** Displays peak levels for 3 seconds
- **Inf Hold** Displays peak levels until meters are cleared
- **No Hold** Does not display peak levels

**Reference Mark Options**

Each SignalTools meter type lets you adjust the level of the reference mark on the side of the meter display. The mark is set by default to the reference level for the corresponding meter type.

💡 *SignalTools meters also change color to show different ranges of level. The relative range of color automatically adjusts to follow the current Reference Mark setting in all meter types (except Peak+RMS).*

To change the reference level of a SignalTools meter:

- Drag the reference mark to a different location on the meter scale.
The TimeAdjuster plug-in provides three functions:

- Compensation for delays due to TDM- or RTAS-based routing
- Gain compensation (+/– 24 dB)
- Phase inversion for correcting out-of-phase signals

For special information on Delay Compensation and Time Adjuster, see the Pro Tools Reference Guide.

The TimeAdjuster plug-in is an efficient way to compensate for DSP or host-based processing delays in your Pro Tools system.

There are three versions of the TimeAdjuster plug-in, each of which supports different sample delay ranges:

**Short** Supports a maximum delay of 256 samples at all sample rates.

**Medium** Supports a maximum delay of 2048 samples at all sample rates.

**Long** Supports a maximum delay of 8192 samples at all sample rates.
**Delay** Provides up to 8192 samples of delay compensation adjustment, or general adjustment of phase relationships of audio recorded with multiple microphones, depending on which version of TimeAdjuster is used. It defaults to a minimum delay of four samples, which is the delay created by use of the TimeAdjuster plug-in itself.

While phase inversion controls have been used for many years by engineers as creative tools for adjustment of frequency response between multiple microphones, sample-level delay adjustments provide far more control. Creative use of this control can provide a powerful tool for adjusting frequency response and timing relationships between audio signals recorded with multiple microphones.

**Using TimeAdjuster for Manual Delay Compensation**

DSP and host-based processing in all digital systems incurs delay of varying amounts. You can use the TimeAdjuster TDM plug-in to apply an exact number of samples of delay to the signal path of a Pro Tools track to compensate for delay incurred by specific plug-ins. TimeAdjuster provides presets for common delay-compensation scenarios.

To compensate for several plug-ins in-line, use the delay times from each settings file as references, and add them together to derive the total delay time.

⚠️ Some plug-ins (such as Digidesign’s Maxim and DINR BNR) have different delays at different sample rates. Refer to the Digidesign Plug-ins Guide for more information about these plug-ins.

Alternatively, look up the delay in samples for the plug-ins you want to compensate for, then apply the appropriate amount of delay.

spender

A delay table for DigiRack plug-ins appears in Appendix B, “DSP Delays Incurred by TDM Plug-ins.”

To manually compensate for DSP-induced delays, try one of the following methods:
- Phase inversion
  - or –
- Comb-filter effect cancellation

**Phase Inversion**

If you are working with phase-coherent track pairs, or tracks recorded with multiple microphones, you can invert the phase to negate the delay. If you don’t hear any audio when you invert a signal’s phase, you have precisely adjusted and compensated for the delay. This is because when you monitor duplicate signals and invert the polarity (phase) of one of them, the signals will be of opposite polarity and cancel each other out. This technique is convenient for finding the exact delay setting for any plug-in.

**To determine the delay of a plug-in by inverting its signal phase:**

1. Place duplicate audio regions on two different audio tracks and pan them to the center (mono).
2. Apply the plug-in whose delay you want to calculate to the first track, and a Time Adjuster plug-in to the second track.
3. With TimeAdjuster, invert the phase.
4. Control-drag (Windows) or Command-drag (Mac) to fine-tune delay in one sample increments, or use the up/down arrow keys to change the delay one sample at a time until the audio signal disappears.
5 Change the polarity back to normal.

6 Save the TimeAdjuster setting for later use.

**Comb-Filter Effect Cancellation**

Adjust the delay with the signal in phase until any comb-filter effects cancel out.

**Viewing Channel Delay**

Because plug-ins display their delay values in the channel delay indicators, this can be used as another method for determining delay compensation.

To view time delay values and use TimeAdjuster to compensate for the delay:

1 Control-click (Windows) or Command-click (Mac) the Track Level Indicator to toggle between level (that appears on the display as “vol”), headroom (“pk”), and channel delay (“dly”) indications. Delay values are shown in samples.

2 Apply the TimeAdjuster plug-in to the track whose delay you want to increase, and Control-click (Windows) or Command-click (Mac) its Track Level indicator until the channel delay value is displayed for that track.

3 Change the delay time in TimeAdjuster by moving the Delay slider or entering a value in the Delay field, until the channel delay value matches that of the first track.

4 Test the delay values by duplicating an audio track and reversing its phase while compensating for delay.

---

**When to Compensate for Delays**

If you want to compensate for delays across your entire system with Time Adjuster, you will want to calculate the maximum delay incurred on any channel, and apply the delays necessary to each channel to match this channel.

However, this may not always be necessary. You may only really need to compensate for delays between tracks where phase coherency must be maintained (as with instruments recorded with multiple microphones or stereo pairs). If you are working with mono signals, and the accumulated delays are small (just a few samples, for example), you probably needn’t worry about delay compensation.

For more information about delays and mixing with Pro Tools HD, see the Pro Tools Reference Guide.
The Time Compression/Expansion plug-in adjusts the duration of selected regions, increasing or decreasing their length without changing pitch.

**Source and Destination** The Source fields display the length of the current selection before processing in each of the listed formats. All fields are always active; a change made to one value is immediately reflected in the others.

The Destination fields both display and control the final length of the selection after processing. Enter the length of the Destination file by double-clicking the appropriate field in the Destination column.

Use the Ratio, Crossfade, Min Pitch, and Accuracy controls to fine-tune the Time Compression/Expansion process.

**Ratio** Sets the destination length in relation to the source length. Moving the slider to the right increases the length of the destination file, while moving the slider to the left decreases its length.

**Crossfade** Adjusts the crossfade length in milliseconds, optimizing performance of the Time Compression/Expansion according to the type of audio material being processed. (This plug-in achieves length modification by replicating or subtracting very small portions of audio material and very quickly crossfading between these alterations in the waveform of the audio material.)

*Normalizing a selection before using Time Compressing/Expansion may produce better results.*
Crossfade length affects the amount of smoothing performed on audio material. This prevents audio artifacts such as clicks from occurring. Long crossfade times may over-smooth a signal and its transients. This may not be desirable on drums and other material with sharp transients.

Use the Crossfade slider to manually adjust and optimize crossfade times if necessary. For audio material with sharper attack transients, use smaller crossfade times. For audio material with softer attack transients, use longer crossfade times.

**Min Pitch** Sets the minimum, or lowest, pitch that will be used in the plug-in’s calculations during the Time Compression/Expansion process. The control has a range of 40 Hz to 1000 Hz.

This control should be set lower when processing bass guitar or audio material with a low frequency range. Set this control higher when processing higher frequency range audio material.

**Accuracy** Prioritizes the processing resources allocated to audio quality (Sound) or timing (Rhythm). Moving the slider towards “Sound” generally results in better sonic quality and fewer audio artifacts. Moving the slider towards “Rhythm” puts the emphasis on keeping the tempo consistent.

When you are working with audio loops, listen carefully and adjust the Accuracy slider until you find a setting that keeps timing solid within the region. If you don’t, start and end times may be precise, but the beats in rhythmic material may appear to be shuffled if too little priority is given to Rhythm.

⚠️ Time Compression & Expansion settings created in version 4.x and later of Pro Tools for Windows are not compatible with later versions.
Time Shift provides high quality time compression and expansion (TCE) algorithms and formant correct pitch-shifting. Time Shift is ideal for music production, sound design, and post production applications. Use it to manipulate audio loops for tempo matching or to transpose vocal tracks using formant correct pitch shifting. You can also use it in audio post production for pull up and pull down conversions as well as for adjusting audio to specific time or SMPTE durations for synchronization purposes.

**Time Shift Displays and Controls**

The interface for Time Shift is organized in four parts: Audio, Time, Formant or Transient, and Pitch.

**Audio** Use the controls in the Audio section to select the most appropriate time compression and expansion algorithm (mode) for the type of material you want to process, and to attenuate the gain of the processed audio to avoid clipping.

**Time** Use the controls in the Time section to specify the amount of time compression or expansion you want to apply.

**Formant or Transient** Use the controls in the Formant or Transient section to adjust either the amount of formant shift or the transient detection parameters depending upon which mode you have selected in the Audio section. The Formant section is only available when Monophonic is selected as the Audio Mode. The Transient section is available with slightly different controls depending on whether Polyphonic or Rhythmic is selected as the Audio Mode.

**Pitch** Use the controls in the Pitch section to apply pitch shifting. Pitch shifting can also be formant correct if you select the Monophonic audio setting.
**Audio**

The Audio section of Time Shift provides controls for specifying the type of audio you want to process and gain attenuation of the processed signal to avoid clipping.

![Time Shift plug-in, Audio section](image)

**Mode**

The Audio Mode pop-up menu determines the type of TCE and pitch shift algorithm for processing audio: Monophonic, Polyphonic, Rhythmic, or Varispeed.

**Monophonic** Use for processing monophonic sounds (such as a vocal melody).

**Polyphonic** Use for processing complex sounds (such as a multipart musical selection).

**Rhythmic** Use for processing percussive sounds (such as a mix or drum loop).

💡 Rhythmic mode uses transient analysis for time shifting. If you select audio with no apparent transients, or set the Transient Threshold control to a setting above any detected transients, Time Shift assumes a “virtual-transient” every three seconds to be able to process the file. Consequently, the file should be 20 bpm or higher (one beat every three seconds) to achieve desirable results. For material that has no apparent transients, use Monophonic or Polyphonic mode.

**Varispeed** Use to link time and pitch change for tape-like pitch and speed change effects, and post production workflows.

**Range**

The Audio Range pop-up menu determines the frequency range for analysis: Low, Mid, High, or Wide. For low-range material, such as a bass guitar, select Low. For mid-range material, such as male vocals, select Mid. The high range control is for material with a high fundamental frequency, such as female vocals. For more complex material that covers a broad frequency spectrum, select Wide.

In Polyphonic mode, Wide is the default setting and is usually best for all material when using the Polyphonic audio type.

In Monophonic mode, Mid is the default setting and is usually matches the range of most monophonic material.

The range pop-up menu is unavailable in Rhythmic mode and Varispeed mode.

**Gain**

The Audio Gain control attenuates the input level to avoid clipping. Adjust the Gain control from 0.0 dB to –6.0 dB to avoid clipping in the processed signal.

**Clip Indicator**

The Clip indicator indicates clipping in the processed signal. When using time compression or pitch shifting above the original pitch, it is possible for clipping to occur. The Clip indicator lights when the processed signal is clipping. If the processed signal clips, undo the AudioSuite process and attenuate the input gain using the Gain control. Then, re-process the selection.

**Level Indicator**

The Level indicator displays the level of the output signal using a plasma LED, which uses the full range of plasma level metering colors.
**Time**

The Time section of Time Shift provides controls for specifying the amount of time compression or expansion as well as the timebase used for calculating TCE. Adjust the Time control to change the target duration for the processed audio.

![Time Shift plug-in, Time section](image)

**Original** Displays the Start and End times, and Length of the edit selection. Times are displayed in units of the timebase selected in the Units pop-up menu.

**Processed** Displays the target End time and Length of the processed signal. Times are displayed in units of the timebase selected in the Units pop-up menu. You can click the Processed End and Length fields to type the desired values. These values update automatically when adjusting the Time control.

**Tempo** Displays the Original Tempo and Processed Tempo in beats per minute (bpm). You can click the Original Tempo and Processed Tempo fields to type the desired values. The Processed Tempo value updates automatically when adjusting the Time control.

**Unit** Select the desired timebase for the Original and Processed time fields: Bars|Beats, Min:Sec, Time Code, Feet+Frames, or Samples.

⚠️ *Time Shift does not receive Bars|Beat and Feet+Frame information from Pro Tools 7.0 or 7.1. Consequently, Bars|Beats and Feet+Frames are displayed as “N/A.”*

**Speed** Displays the target time compression or expansion as a percentage of the original. Adjust the Time control or click the Speed field and type the desired value. Time can be changed from 25.00% to 400.00% of the original speed (or 4 to 1/4 times the original duration). The default setting is 100.00%, or no change. 25.00% results in 4 times the original duration and 400.00% results in 1/4 of the original duration.

The Speed field only displays up to 2 decimal places, but lets you type in as many decimal places as you want (up to the IEEE standard). While the display rounds to 2 decimal places, the actual time shift is applied based on the number you typed. This is especially useful for typing post production pull up and pull down factors (see “Post Production Pull Up and Pull Down Tasks” on page 90).

**Formant**

The Formant section of Time Shift lets you shift the formant shape of the selected audio independently of the fundamental frequency. This is useful for achieving formant correct pitch shifting. It can also be used as an effect. For example, you can formant shift a male vocal up by five semitones and it will take on the characteristics of a female voice.

The Formant section is only available when Monophonic is selected as the Audio Type. The Formant section provides a single control for transposing the formants of the selected audio.
by –24.00 semitones (–2 octaves) to +24.00 semitones (+2 octaves), with fine resolution in cents. Adjust the Formant Shift control or click the Shift field and type the desired value.

**Time Shift plug-in, Formant section**

💡 Audio with a fundamental pitch has an overtone series, or set of higher harmonics. The strength of these higher harmonics creates a formant shape, which is apparent if viewed using a spectrum analyzer. The overtone series, or harmonics, have the same spacing related to the pitch and have the same general shape regardless of what the fundamental pitch is. It is this formant shape that gives the audio its overall characteristic sound or timbre. When pitch shifting audio, the formant shape is shifted with the rest of the material, which can result in an unnatural sound. Keeping this shape constant is critical to formant correct pitch shifting and achieving a natural sounding result.

**Transient**

The Transient section is only available when Polyphonic or Rhythmic is selected as the Audio Type, and provides slightly different controls for each.

When Polyphonic is selected as the Audio Type, the Transient section provides controls for setting the transient detection threshold and for adjusting the analysis window length for processing audio.

When Rhythmic is selected as the Audio Type, the Transient section provides controls for setting the transient detection threshold, and for adjusting the decay rate of the transients in the processed audio when time stretching.

**Follow** Enables an envelope follower that simulates the original acoustics of the audio being stretched. Click the Follow button to enable or disable envelope following. Follow is only available when Polyphonic is selected as the Audio Type.

**Threshold** Sets the transient detection threshold from 0.0 dB to –40.0 dB. Disable transient detection by setting the Threshold control to Off (turn the knob all the way to the right). Part of Time Shift’s processing relies upon separating “transient” parts of the selection from “non-transient” parts. Transient material tends to
change its content quickly in time, as opposed to parts of the sound which are more sustained. Adjust the Threshold control or click the Threshold field and type the desired value.

The default value for Threshold is –6.0 dB. For highly percussive material, lower the threshold for better transient detection, especially with the Rhythmic audio setting. For less percussive material, and for shifting with the Polyphonic audio setting, a higher setting can yield better results. Experiment with this control, especially when shifting drums and percussive tracks, to achieve the best results.

**Window** Sets the analysis window length for processing audio. You can set the Window from 6.0 milliseconds to 185.0 milliseconds. Adjust the Window control or click the Window field and type the desired value. The Window control is only available when Polyphonic is selected as the Audio Type.

The default for Window size is 18.0 milliseconds and works well for many applications, but you may want to try different Window settings to get the best results. Try larger window sizes for low frequency sounds or sounds that do not have many transients. Try smaller window sizes for drums and percussion. 37.0 milliseconds tends to work well for polyphonic instruments such as piano or guitar. A setting as large as 71.0 milliseconds works well for bass guitar. Settings in the 12 millisecond range work well on drums or percussion.

**Decay Rate** Determines how much of the decay from a transient is heard in the processed audio when time stretching. When time stretching using the Rhythmic setting, the resulting gaps between the transients are filled in with audio, and Decay Rate determines how much of this audio is heard by applying a fade out rate. Decay Rate is only available when Rhythmic is selected as the Audio Type. Adjust the Decay Rate up to 100% to hear the audio that is filling the gaps created by the time stretching with only a slight fade, or adjust down to 1.0% to completely fade out between the original transients.

**Pitch**

The Pitch section provides controls for pitch shifting the selected audio. Use the Pitch control to transpose the pitch from –24.00 semitones (–2 octaves) to +24.00 semitones (+2 octaves), with fine resolution in cents.

**Transpose** Displays the transposition amount in semitones. You can transpose pitch from –24.00 semitones (–2 octaves) to +24.00 semitones (+2 octaves), with fine resolution in cents. Adjust the Pitch control or click the Transpose field and type the desired value.

**Shift** Displays the pitch shift amount as a percentage. You can pitch shift from 25.00% (–2 octaves) to +400.00% (+2 octaves). Adjust the Pitch control or click the Shift field and type the desired value. The default value is 100% (no pitch shift).
Post Production Pull Up and Pull Down Tasks

Table 1 on page 90 provides information on TCE settings for common post production tasks. Type the corresponding TCE% (represented to 10 decimal places in Table 1) in the Time Shift field for the corresponding post production task and the process the selected audio.

💡 Use the corresponding Time Shift Plug-in Setting for the desired post production task.

### Table 1. Most commonly used TCE settings in Post workflows

<table>
<thead>
<tr>
<th>Post Workflow Plug-in Setting</th>
<th>TCE% (to 10 Decimal Places)</th>
<th>Frames</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pal to Film –4%.tfx</td>
<td>96.0%</td>
<td>25 to 24/30</td>
</tr>
<tr>
<td>PAL to NTSC –4.1%.tfx</td>
<td>95.9040959041%</td>
<td>25 to 23.976/29.97</td>
</tr>
<tr>
<td>Film to PAL +4.1667%.tfx</td>
<td>+104.1666666667%</td>
<td>24/30 to 25</td>
</tr>
<tr>
<td>Film to NTSC –0.1%.tfx</td>
<td>99.9000999001%</td>
<td>24/30 to 23.976/29.97</td>
</tr>
<tr>
<td>NTSC to Pal +4.2667%.tfx</td>
<td>+104.2708333333%</td>
<td>23.976/29.97 to 25</td>
</tr>
<tr>
<td>NTSC to Film +0.1%.tfx</td>
<td>+100.10%</td>
<td>23.976/29.97 to 24/30</td>
</tr>
</tbody>
</table>
AudioSuite Input Modes

Time Shift supports the Pro Tools AudioSuite Input Mode selector for use on mono or multi-input processing.

**Mono Mode** Processes each audio region as a mono file with no phase coherency maintained with any other simultaneously selected regions.

**Multi-Input Mode** Processes up to 48 input channels and maintains phase coherency within those selected channels.

AudioSuite Preview

Time Shift supports Pro Tools AudioSuite Preview and Bypass. For more information on using AudioSuite Preview and Bypass, see the DigiRack Plug-ins Guide.

⚠️ *AudioSuite Preview and Bypass are unavailable with Time Shift in Pro Tools 7.0 and 7.1.*

AudioSuite TCE Plug-in Preference

The Time Shift plug-in’s high quality time compression and expansion algorithms that can be used with the Pro Tools TCE Trim tool.

⚠️ *Time Shift is not available with the TCE Trim tool in Pro Tools 7.0 and 7.1.*

⚠️ *Refer to the Pro Tools Reference Guide for more information about the TCE Trim tool.*

**To select Time Shift for use with the TCE Trim tool:**

1. Choose Setup > Preferences.
2. Click the Processing tab.
3. From the TC/E Plug-in pop-up menu, select Time Shift.
4. Select the desired preset setting from the Default Settings pop-up menu.
5. Click OK.
Processing Audio

Time Shift lets you change the time and pitch of selected audio independently or concurrently.

💡 Normalizing a selection before using Time Shift may produce better results.

To change the time of a selected audio region:
2. Select the Audio Mode appropriate to the type of material you are processing (Monophonic, Polyphonic, or Rhythmic).
3. In Monophonic or Polyphonic mode, select the appropriate Range for the selected material (Low, Mid, High, or Wide).
4. If compressing the duration of the selection, attenuate the Gain control as necessary.
5. If using Monophonic mode, adjust the Formant Shift control as desired.
6. If using Polyphonic or Rhythmic mode, adjust the Transient controls as desired.
7. Make sure Pitch Shift is set to 0% (unless you also want to change the duration of the section).
8. Adjust the Time Shift control to the desired amount of time change. Time change is measured in terms of the target duration using the selected timebase or as a percentage of the original.
9. Click Process.

To change the pitch of a selected audio region:
2. Select the Audio Mode appropriate to the type of material you are processing (Monophonic, Polyphonic, or Rhythmic).
3. In Monophonic or Polyphonic mode, select the appropriate Range for the selected material (Low, Mid, High, or Wide).
4. If transposing the pitch of the selection up, attenuate the Gain control as necessary.
5. If using Monophonic mode, adjust the Formant Shift control as desired.
6. If using Polyphonic or Rhythmic mode, adjust the Transient controls as desired.
7. Make sure Time Shift is set to 0% (unless you also want to change the duration of the section).
8. Adjust the Pitch Shift control to the desired amount of pitch change. Pitch change is measured in semitones (and cents) or as a percentage of the original.
9. Click Process.

To change the time and pitch of a selected audio region:
2. Select Varispeed from the Audio Mode pop-up menu.
3. Adjust either the Time Shift or Pitch Shift control to match the desired amount of time and pitch change in terms of a percentage of the original.
4. Click Process.

💡 Using the Monophonic, Polyphonic, or Rhythmic modes, you can adjust both the Time Shift and Pitch Shift controls independently before processing.
The Trim plug-in can be used to attenuate an audio signal from $-\infty$ (Infinity) dB to +6 dB or $-\infty$ (Infinity) dB to +12 dB. For example, using a multi-mono Trim plug-in on a multi-channel track provides simple, DSP-efficient muting control over the individual channels of the track.

This capability is useful, since Track Mute buttons mute all channels of a multi-channel track and do not allow muting of individual channels within the track.

**Trim Controls**

**Phase Invert** Inverts the phase (polarity) of the input signal to change the frequency response characteristics between multi-miked sources or to correct for miswired microphone cables.

**Gain** Provides $-\infty$ dB to +6 dB or +12 dB of gain adjustment, depending whether the Gain toggle is set to +6 or +12.

**+6/+12 Gain Toggle** Switches the maximum level of attenuation between $-\infty$ dB to +6 dB and $-\infty$ dB to +12 dB.

⚠️ Automation data adjusts to reflect the current Gain setting. When working with automation data from an older version of the Trim plug-in, ensure the Gain setting is set at +6 dB.

**Output Meter** Indicates the output level, including any gain compensation added using the Gain control.

**Mute** Mutes the signal output.

💡 Alt-click (Windows) or Option-click (Mac) the Trim selector to open a Plug-in window for each channel of a multi-channel track.

See also “Linking and Unlinking Controls on Multi-Mono Plug-ins” on page 21.
Other AudioSuite Plug-ins

(AudioSuite Only)

DC Offset Removal

The DC Offset Removal plug-in removes DC offset from audio files. DC offset is a type of audio artifact (typically caused by miscalibrated analog-to-digital convertors) that can cause pops and clicks in edited material.

To check for DC offset, find a silent section in the audio material. If DC offset is present, a near-vertical fade-in with a constant or steady-state offset from zero will appear in the waveform. Use the DC Offset Removal plug-in to remove it.

Duplicate

The Duplicate plug-in duplicates the selected audio in place. Depending on how its controls are configured, the new region will appear in either the Regions List or playlist. You can use this to flatten or consolidate an entire track consisting of multiple regions into one continuous audio file that resides in the same place as the original individual regions.

To remove DC offset from an audio region:

1. Select the region with DC offset.
2. Choose AudioSuite > Other > DC Offset Removal.
3. Ensure that Use In Playlist is enabled.
4. Click Process.

Duplicate plug-in

The audio is unaffected by Pro Tools volume or pan automation, or by any real-time plug-ins that may be in use on the track as inserts. The original audio file regions are merely rewritten in place to a single duplicate file.

The Duplicate plug-in works nondestructively. You cannot choose to overwrite files.
To duplicate an audio selection:

1. Select the audio you want to duplicate.
2. Choose AudioSuite > Other > Duplicate.
3. Ensure that Use In Playlist is enabled.
4. Click Process.

**Gain**

The Gain plug-in boosts or lowers a selected region’s amplitude by a specific amount. Use it to smooth out undesired peaks and other dynamic inconsistencies in audio material.

Gain plug-in

- **Gain** Specifies the desired gain level. Set this value by manually adjusting the Gain slider, or by entering a numeric decibel value, or by entering a percentage.

- **Find Level** When clicked, displays the peak amplitude value of the current selection.

- **RMS/Peak Toggle** Switches the calibration of gain adjustment between Peak or RMS modes. Peak mode adjusts the gain of the input signal to the maximum possible level without clipping. RMS mode adjusts the input signal to a level consistent with the RMS (Root-Mean-Square) value, or the effective average level of the selected region.

To change the gain of an audio region:

1. Select the region whose gain you want to change.
2. Choose AudioSuite > Other > Gain.
3. Adjust the Gain slider as desired.
4. Click Preview to audition your changes.
5. Ensure that Use In Playlist is enabled.
6. Click Process.

**Invert**

The Invert plug-in reverses the polarity of selected audio. Positive sample amplitude values are made negative, and all negative amplitudes are made positive.

This process is useful for altering the phase or polarity relationship of tracks. The Invert plug-in is useful during mixing for modifying frequency response between source tracks recorded with multiple microphones. You can also use it to correct audio recorded out of phase with an incorrectly wired cable.

Invert plug-in

To invert the phase an audio region (or selection):

1. Select the region whose phase you want to invert.
2. Choose AudioSuite > Other > Invert.
3. Ensure that Use In Playlist is enabled.
4. Click Process.
Normalize

The Normalize plug-in optimizes the volume level of an audio selection. Use it on material recorded with too little amplitude, or on material whose volume levels are inconsistent (as in a poorly recorded narration).

Unlike compression and limiting, which modify the dynamics of audio material, normalization preserves dynamics by uniformly increasing (or decreasing) amplitude.

To prevent clipping during sample rate conversion, Normalize to no greater than the range between –2 dB to –0.5 dB. Optimum settings will vary with your program material and your Conversion Quality setting (in the Editing tab of the Preferences dialog).

 Normalize plug-in

Max Peak At Specifies how close to maximum level (clipping threshold) the peak level of a selection is boosted. Set this value by adjusting the Max Peak At slider, by entering a numeric decibel value below the clipping threshold, or by entering a percentage of the clipping threshold.

You can normalize stereo pairs together so that two sides of a stereo signal are processed relative to each other.

RMS/Peak Toggle Switches the calibration of normalizing between Peak or RMS modes. Peak mode normalizes the input signal at the maximum possible level without clipping. RMS mode normalizes the input signal at a level consistent with the RMS (Root-Mean-Square) value, or the effective average level of the selected region.

Normalizing Multiple Regions Across Tracks

When multiple regions are selected across multiple tracks, the Normalize plug-in can search for peaks in two different modes:

Peak On Each Chan/Track Searches for the peak level on a channel-by-channel or track-by-track basis.

Peak On All Chans/Tracks Searches for the peak level of the entire selection. If ten tracks are selected, for example, the Normalize function will find the peak value from all ten.

To normalize an audio region (or selection):

1 Select the region you want to normalize.
2 Choose AudioSuite > Other > Normalize.
3 Adjust the Level slider as desired.
4 Ensure that Use In Playlist is enabled.
5 Click Process.

To prevent clipping during sample rate conversion, Normalize to no greater than the range between –2 dB to –0.5 dB. Optimum settings will vary with your program material and your Conversion Quality setting (in the Editing tab of the Preferences dialog).
Reverse

The Reverse plug-in replaces the audio with a reversed version of the selection. This is useful for creating reverse envelope effects for foley, special effects, or musical effects (for example, the reverse piano attack at the end of the Beatles’ song *A Day in the Life*).

Reverse plug-in

To reverse an audio region (or selection):

1. Select the region you want to reverse.
2. Choose AudioSuite > Other > Reverse.
3. Ensure that Use In Playlist is enabled.
4. Click Process.
The number of TDM plug-ins you can use at one time depends on how much DSP power is available in your system. Since the TDM hardware on Pro Tools cards provide dedicated DSP for plug-ins, plug-in performance is not limited by CPU processing power.

The DSP tables on the following pages show the theoretical total number of instances of each DigiRack TDM plug-in that can be powered by a single DSP chip on Pro Tools|HD-series cards. DSP usage differs according to card type and DSP chip availability.

DSP tables show the theoretical maximum performance when no other plug-ins or system tasks (such as I/O) are sharing available DSP resources. You will typically use more than one type of plug-in simultaneously. The data in these tables are provided as guidelines to help you gauge the relative efficiency of different plug-ins on your system. They are not guaranteed performance counts that you should expect to see in typical real-world sessions and usage.

There are a total of nine DSP chips on a Pro Tools|HD card (HD Core, HD Process, and HD Accel). HD Core and HD Process cards provide identical chip sets. HD Accel cards provide newer, more powerful DSP chips (making the HD Accel card ideal for DSP-intensive plug-ins, and for high sample rate sessions).

Not all plug-ins are supported on all types of chips. The following tables indicate the number of compatible chips per card.
DSP Requirements

DSP requirements for DigiRack TDM plug-ins are provided on the following pages.

Mono and Stereo DigiRack Plug-ins on HD Cards

The following table compares the maximum number of instances of each DigiRack TDM plug-in that can be powered by a single DSP chip on an HD Accel card to that of HD Core and HD Process cards.

*Maximum instances of real-time TDM plug-ins per DSP chip for Pro Tools|HD cards at 44.1 and 48 kHz*

<table>
<thead>
<tr>
<th>Plug-in</th>
<th>HD Accel</th>
<th>HD Core and HD Process</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>mono/stereo</td>
<td>mono/stereo</td>
</tr>
<tr>
<td>EQ III (1-band)</td>
<td>66</td>
<td>33</td>
</tr>
<tr>
<td>EQ III (2–4 band)</td>
<td>36</td>
<td>18</td>
</tr>
<tr>
<td>EQ III (7-band)</td>
<td>23</td>
<td>11</td>
</tr>
<tr>
<td>Click</td>
<td>18</td>
<td>n/a</td>
</tr>
<tr>
<td>Dither</td>
<td>46</td>
<td>43</td>
</tr>
<tr>
<td>D-Verb</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>Compressor/Limiter III</td>
<td>18</td>
<td>11</td>
</tr>
<tr>
<td>Expander/Gate III</td>
<td>16</td>
<td>11</td>
</tr>
<tr>
<td>De-Esser III</td>
<td>12</td>
<td>8</td>
</tr>
<tr>
<td>Mod Delay II (short)</td>
<td>74</td>
<td>36</td>
</tr>
<tr>
<td>Mod Delay II (slap)</td>
<td>73</td>
<td>36</td>
</tr>
<tr>
<td>Mod Delay II (medium)</td>
<td>36</td>
<td>18</td>
</tr>
<tr>
<td>Mod Delay II (long)</td>
<td>17</td>
<td>7</td>
</tr>
<tr>
<td>Mod Delay II (extra long)</td>
<td>4</td>
<td>2</td>
</tr>
<tr>
<td>Pitch</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>POW-r Dither</td>
<td>22</td>
<td>10</td>
</tr>
<tr>
<td>Signal Generator</td>
<td>48</td>
<td>n/a</td>
</tr>
<tr>
<td>PhaseScope (SignalTools)</td>
<td>n/a</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td></td>
<td>n/a</td>
</tr>
</tbody>
</table>
Appendix A: DSP Requirements for TDM Plug-ins

Maximum instances of real-time TDM plug-ins per DSP chip for Pro Tools|HD cards at 44.1 and 48 kHz

<table>
<thead>
<tr>
<th>Plug-in</th>
<th>HD Accel</th>
<th>HD Core and HD Process</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>mono/stereo</td>
<td>mono/stereo</td>
</tr>
<tr>
<td>Time Adjuster (short)</td>
<td>146</td>
<td>117</td>
</tr>
<tr>
<td>Time Adjuster (medium)</td>
<td>32</td>
<td>114</td>
</tr>
<tr>
<td>Time Adjuster (long)</td>
<td>72</td>
<td>32</td>
</tr>
<tr>
<td>Trim</td>
<td>145</td>
<td>119</td>
</tr>
</tbody>
</table>

Maximum instances are approximately half at 88.2 kHz and 96 kHz, and approximately a quarter at 176.4 and 192 kHz. Actual results will likely be less due to system and session variables.

Multi-Mono and Multi-Channel DigiRack Plug-ins

Plug-ins used in multi-mono format on greater-than-stereo tracks require one mono instance per channel of the multi-channel audio format. A multi-mono EQ used on a 5.1 format track, for example, requires six mono instances since there are six audio channels in the 5.1 format. Because multi-channel versions of the Compressor II, Limiter II, and Expander/Gate II plug-ins are available for use on greater-than-stereo tracks, separate instance counts are given for those configurations.

Table 1. Theoretical maximum instances of real-time TDM plug-ins per DSP chip for a Pro Tools HD Core and HD Process card at 48 kHz**

<table>
<thead>
<tr>
<th>Plug-in</th>
<th>LCR</th>
<th>Quad &amp; LCRS</th>
<th>5.0</th>
<th>5.1 &amp; 6.0</th>
<th>6.1 &amp; 7.0</th>
<th>7.1</th>
<th>DSP Chips per HD Card</th>
</tr>
</thead>
<tbody>
<tr>
<td>DigiRack Pitch</td>
<td>partial</td>
<td>partial</td>
<td>partial</td>
<td>partial</td>
<td>partial</td>
<td>partial</td>
<td>9</td>
</tr>
<tr>
<td>D-Verb</td>
<td>partial</td>
<td>partial</td>
<td>partial</td>
<td>partial</td>
<td>partial</td>
<td>partial</td>
<td>9</td>
</tr>
<tr>
<td>Compressor/Limiter III</td>
<td>3</td>
<td>3</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>9</td>
</tr>
<tr>
<td>Expander/Gate III</td>
<td>3</td>
<td>3</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>9</td>
</tr>
<tr>
<td>De-Esser III</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mod Delay I (short)</td>
<td>14</td>
<td>11</td>
<td>8</td>
<td>7</td>
<td>6</td>
<td>5</td>
<td>9</td>
</tr>
<tr>
<td>Mod Delay I (slap)</td>
<td>10</td>
<td>8</td>
<td>6</td>
<td>5</td>
<td>4</td>
<td>4</td>
<td>9</td>
</tr>
<tr>
<td>Mod Delay I (medium)</td>
<td>5</td>
<td>4</td>
<td>3</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>9</td>
</tr>
<tr>
<td>Mod Delay I (long)</td>
<td>partial</td>
<td>partial</td>
<td>partial</td>
<td>partial</td>
<td>partial</td>
<td>partial</td>
<td>9</td>
</tr>
<tr>
<td>Mod Delay II (short)</td>
<td>14</td>
<td>11</td>
<td>8</td>
<td>7</td>
<td>6</td>
<td>5</td>
<td>9</td>
</tr>
</tbody>
</table>
**Table 1. (Continued) Theoretical maximum instances of real-time TDM plug-ins per DSP chip for a Pro Tools HD Core and HD Process card at 48 kHz**

<table>
<thead>
<tr>
<th>Plug-in</th>
<th>LCR</th>
<th>Quad &amp; LCRS</th>
<th>5.0</th>
<th>5.1 &amp; 6.0</th>
<th>6.1 &amp; 7.0</th>
<th>7.1</th>
<th>DSP Chips per HD Card</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mod Delay II (slap)</td>
<td>10</td>
<td>8</td>
<td>6</td>
<td>5</td>
<td>4</td>
<td>4</td>
<td>9</td>
</tr>
<tr>
<td>Mod Delay II (medium)</td>
<td>5</td>
<td>4</td>
<td>3</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>9</td>
</tr>
<tr>
<td>Mod Delay II (long)</td>
<td>2</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>9</td>
</tr>
<tr>
<td>Mod Delay II (extra long)</td>
<td>partial</td>
<td>partial</td>
<td>partial</td>
<td>partial</td>
<td>partial</td>
<td>partial</td>
<td>9</td>
</tr>
<tr>
<td>Dither</td>
<td>12</td>
<td>9</td>
<td>7</td>
<td>6</td>
<td>5</td>
<td>4</td>
<td>9</td>
</tr>
<tr>
<td>POW-r Dither</td>
<td>3</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>9</td>
</tr>
<tr>
<td>Signal Generator*</td>
<td>8</td>
<td>6</td>
<td>5</td>
<td>4</td>
<td>3</td>
<td>3</td>
<td>9</td>
</tr>
<tr>
<td>SurroundScope (SignalTools)</td>
<td>4</td>
<td>3</td>
<td>2</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>9</td>
</tr>
<tr>
<td>Time Adjuster (short)</td>
<td>30</td>
<td>22</td>
<td>18</td>
<td>15</td>
<td>13</td>
<td>11</td>
<td>9</td>
</tr>
<tr>
<td>Time Adjuster (medium)</td>
<td>30</td>
<td>22</td>
<td>18</td>
<td>15</td>
<td>13</td>
<td>11</td>
<td>9</td>
</tr>
<tr>
<td>Time Adjuster (long)</td>
<td>10</td>
<td>8</td>
<td>6</td>
<td>5</td>
<td>4</td>
<td>4</td>
<td>9</td>
</tr>
<tr>
<td>Trim*</td>
<td>39</td>
<td>29</td>
<td>23</td>
<td>19</td>
<td>16</td>
<td>14</td>
<td>9</td>
</tr>
</tbody>
</table>

“Partial” indicates that a single instance of the multi-mono plug-in is sharing more than 1 DSP chip.

* Instance counts are provided for multi-mono versions of plug-ins that have no available multichannel version.

** Maximum instances are approximately half at 88.2 kHz and 96 kHz, and approximately a quarter at 176.4 and 192 kHz. Actual results will likely be less due to system and session variables.

**Monitoring DSP Usage**

The System Usage window (Window > System Usage) shows approximately how much DSP is available in your system and how it is being used in the current Pro Tools session.

For more information about DSP usage and allocation, see the Pro Tools Reference Guide.
Virtually all TDM plug-ins incur some amount of signal delay.

If you are working with mono tracks, or are processing all channels with the same plug-in, the signal delays are not long enough to be significant and should not be a concern.

This signal delay is significant only if you use a plug-in on one channel of a stereo or multichannel signal but not the others, since this can cause the channels to be slightly out of phase.

Pro Tools systems provide automatic Delay Compensation (and other methods) to compensate for signal processing delays. For detailed information, see the Pro Tools Reference Guide.

Table 2 shows the delays inherent in each type of Digidesign TDM plug-in.

<table>
<thead>
<tr>
<th>Plug-in</th>
<th>Samples of Delay on HD Cards</th>
</tr>
</thead>
<tbody>
<tr>
<td>EQ III (1-band)</td>
<td>4</td>
</tr>
<tr>
<td>EQ III (2–4 band)</td>
<td>4</td>
</tr>
<tr>
<td>EQ III (7-band)</td>
<td>4</td>
</tr>
<tr>
<td>Compressor II</td>
<td>4</td>
</tr>
<tr>
<td>De-esser</td>
<td>4</td>
</tr>
<tr>
<td>DigiRack Pitch</td>
<td>3</td>
</tr>
<tr>
<td>D-Verb</td>
<td>3</td>
</tr>
<tr>
<td>Compressor/Limiter III</td>
<td>4</td>
</tr>
<tr>
<td>Expander/Gate III</td>
<td>92</td>
</tr>
<tr>
<td>De-Esser III</td>
<td>4</td>
</tr>
<tr>
<td>Limiter II</td>
<td>4</td>
</tr>
<tr>
<td>Gate II</td>
<td>4</td>
</tr>
<tr>
<td>Expander/Gate II</td>
<td>4</td>
</tr>
<tr>
<td>Mod Delay I/II (short)</td>
<td>4</td>
</tr>
<tr>
<td>Mod Delay I/II (slap)</td>
<td>4</td>
</tr>
</tbody>
</table>

Table 2. Samples of delay incurred by each real-time DigiRack TDM plug-in on HD cards
Table 2. (Continued) Samples of delay incurred by each real-time DigiRack TDM plug-in on HD cards

<table>
<thead>
<tr>
<th>Plug-in</th>
<th>Samples of Delay on HD Cards</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mod Delay I/II (medium)</td>
<td>4</td>
</tr>
<tr>
<td>Mod Delay I/II (long)</td>
<td>4</td>
</tr>
<tr>
<td>Mod Delay II (extra long)</td>
<td>4</td>
</tr>
<tr>
<td>Dither</td>
<td>4</td>
</tr>
<tr>
<td>POW-r Dither</td>
<td>4</td>
</tr>
<tr>
<td>SansAmp PSA-1</td>
<td>3</td>
</tr>
<tr>
<td>Signal Generator</td>
<td>4</td>
</tr>
<tr>
<td>SignalTools SurroundScope</td>
<td>4</td>
</tr>
<tr>
<td>SignalTools PhaseScope</td>
<td>4</td>
</tr>
<tr>
<td>Time Adjuster</td>
<td>4</td>
</tr>
</tbody>
</table>
Numerics
7 Band, 2–4 Band, or 1 Band (EQ III) 35

A
Accuracy control 60, 84
Algorithm control 16
AudioSuite
  Input Mode selector 91
  plug-ins 2
  Preview 91
  processing preferences 91
AudioSuite plug-ins
  DC Offset Removal 95
  Duplicate 95
  Invert 96
  Pitch Shift 59
  Time Compression/Expansion 83

B
BBC (metering) 77
bit resolution for Dither plug-in 14, 61

C
Cents control 56
Church algorithm 16
Click plug-in 5
  Accented control 5
  Unaccented control 5
Clip indicator
  DigiRack Pitch 55
  D-Verb 15
Coarse & Fine controls 59
  compensating for DSP delays 103
Crossfade control 56, 59, 83
Cross-Feedback control 11

D
DC Offset Removal plug-in 95
Decay control 16
delay
  DSP induced 80, 81
Delay control 8, 10, 56
Delay plug-in 51
destination fields 83
Diffusion control 16
DIN (metering) 77
Dither plug-in 13, 61
DSP
  and EQ III 46
DSP delay compensation 80, 81
DSP delays 103
DSP delays inherent in plug-ins 103
Duplicate plug-in 95
D-Verb 15
Dynamics II plug-ins 19

E
EQ
  EQ III 35
EQ III 35
  DSP management 46
  Frequency Graph Display 37
  gain (inverting) 36
Extra Long Delay plug-in 51

F
Feedback control 8, 9, 10, 56
Fine control 56
flattening a track 95
Frequency control 71
Frequency Graph display (EQ III) 37
G
Gain control 10
Gain plug-in 96

H
Hall algorithm 16
HD-series cards
  DSP delays 103
Hi Frequency Cut control 17
High-Pass Filter control 9
host processing 2

I
Input Level control 10
Input mode
  Mono 91
  Multi-Input 91
inverting gain (EQ III) 36

L
Leq(A)
  Auto Reset 76
  Hold on Stop 76
  Reset 76
  Window 76
Leq(A) Meter 76
Level control 71
LFO Rate control 8, 9
LFO Waveform control 8, 9
LFO Width control 8, 9
Lissajous Meter 75
Long Delay plug-in 51
Low-Pass Filter control 7, 17

M
Max Peak At control 97
Maximum Pitch control 57
Medium Delay 51
metering
  BBC 77
  DIN 77
  for VENUE 78
  Leq(A) 76
  level meters 77
  Lissajous in PhaseScope 75
  multichannel SurroundScope 73
  Nordic 77
  Peak 77
  Peak + RMS 77
  peak hold options 78
  Phase Meter 75
  PhaseScope 74
  reference mark 78
  RMS 77
  VU 77
MIDI Beat Clock 52
MIDI Output selector 66
Minimum Pitch control 57, 60, 84
Mix control 7, 10
Mod Delay II plug-ins 51

N
Noise Shaping 14, 61
Nordic (metering) 77
Normalize plug-in 97
Note control 60

O
Output Meter 15
**P**

Pan control 10
Peak 77
Peak + RMS 77
peak hold 78
Peak On All Tracks mode 97
Peak On Each Track mode 97
phase cancellation 80
Phase Invert button 79
Phase Meter 75
PhaseScope 74
pink noise 71
Pitch plug-in 55
Pitch Shift plug-in 59
Pitch transposition 55
plug-ins
  working with 3
POW-r Dither plug-in 61
Pre-delay control 17

**R**

Ratio control 56, 59, 83
reference mark in SignalTools 78
Reference Pitch control 60
Relative Pitch Entry 56
Reset Leq(A) 76
Reverse plug-in 98
ReWire 63
  and voices 65
  automating input switching 70
  client applications 63
  looping playback 69
  meter changes 69
  MIDI automation 67
  playing back MIDI continuous controller (CC) data 68
  plug-in 66
  quitting client applications 68
  recording MIDI continuous controller (CC) data 67
  recording MIDI over 67
  requirements 65
  signal flow for audio and MIDI 64
  software synthesizer 63
  tempo sync 69
  track count 65
  using with Pro Tools 66

RMS 77
RTAS plug-ins 2

**S**

Short Delay plug-in 51
sibilants 28
Signal control 71
signal delay 103
Signal Generator plug-in 53
Signal Present Indicator 55
SignalTools
  level meters 77
Size control 16
Slap Delay plug-in 51
Source and Destination controls 83
SurroundScope 73
System Usage window 102

**T**

TCE Trim tool 91
TDM plug-ins 2
  DSP requirements 99
Tempo Sync 52
  Mod Delay II 52
through-zero flanging 8
Time Compression/Expansion plug-in 83
Time Correction control 59
Time Shift 85
  Audio Gain control 86
  Audio Mode pop-up menu 86
  Audio Range pop-up menu 86
  Audio section 86
  changing pitch 92
  changing time 92
  changing time and pitch 92
  Clip indicator 86
  Decay Rate 89
  displays and controls 85
  Follow button 88
  Formant section 87
  Level indicator 86
  Monophonic mode 86
  Original time 87
  Pitch section 89
  Pitch Shift 89
  Polyphonic mode 86
  post production workflow 90
  Processed time 87
  pull up/pull down TCE percentages 90
  Rhythmic mode 86
  Speed 87
  Tempo displays 87
  Threshold control 88
  Time section 87
  timebase 87
  Transient section 88
  Transpose 89
  Unit pop-up menu 87
  Varispeed mode 86
  Window 89

TimeAdjuster plug-in 79
Trim plug-in 93

V
VENUE
  working with plug-ins 3
VENUE (metering for) 78
voices
  and ReWire 65
VU 77

W
website 4
white noise 71
working with plug-ins 3